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Preface 

Structure of the documentation 
The SINUMERIK documentation comprises three parts: 
• General Documentation 
• User Documentation 
• Manufacturer/Service Documentation 

Reader group 
This manual is intended for users of machine tools with SINUMERIK 840D/840Di/ 
810D and SIMODRIVE 611D. 
 

Hotline 
If you have any questions, please call the hotline: 
 
A&D Technical Support Tel.: ++49-180-5050-222 
    Fax: ++49-180-5050-223 
    Email: www.siemens.de/automation/support-request 
 
Please send any questions about the documentation (suggestions for 
improvement, corrections) to the following fax number or email address: 
 
    Fax:  ++49-9131-98-2176 
    Email:  motioncontrol.docu@siemens.com 
 
Fax form: see reply form at the end of the manual. 
 

Internet address 
http://www.siemens.com/motioncontrol 
 

Aim 
This document explains how to install the SINUMERIK SinuCom NC start-up tool 
and describes its functionality.The purpose of the SinuCom NC start-up and 
servicing tool is to facilitate start-up and installation of the SINUMERIK 
840D/840Di/810D. 
On the SINUMERIK 840D/810D the tool is started from the PG/PC in online mode 
(PG/PC control via OPI). It is included in the SW on the SINUMERIK 840Di. 

Searching aids 
To help you locate information quickly, a table of contents and a keyword index are 
provided. 
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SINUMERIK 840D powerline 
As from 09.2001, the  
• SINUMERIK 840D powerline and 
• SINUMERIK 840DE powerline  
are available with enhanced performance. You will find a list of available powerline 
modules in the hardware manual: 
 
References:  /PHD/ SINUMERIK 840D Configuring Manual 
 

SINUMERIK 810D powerline 
As from 12.2001, the  
• SINUMERIK 810D powerline and 
• SINUMERIK 810DE powerline  
are available with enhanced performance. You will find a list of available powerline 
modules in the hardware manual: 
 
References: /PHC/ SINUMERIK 810D Configuring Manual 
 

Standard scope 
This publication describes the standard scope of functions. Any extensions or 
modifications to the standard scope made by the machine manufacturer will be 
documented by the machine manufacturer. Please contact your local Siemens 
sales office for further information about other publications relating to SINUMERIK 
840D/840Di/810D and publications that are applicable to all SINUMERIK controls 
(e.g. universal interface, measuring cycles ...). 
Other functions not described in this documentation might be executable in the 
control. This does not, however, represent an obligation to supply such functions 
with a new control or when servicing. 
 
References: /IAD/ SINUMERIK 840D Installation Guide 
   /IAC/ SINUMERIK 810D Installation Guide 
   /HBI/ SINUMERIK 840Di Manual 
 

! Important 

This System Description is applicable to the following control types: 
SINUMERIK 840D   7 
SINUMERIK 840DE (export version)  7 
SINUMERIK 840D powerline  7 
SINUMERIK 840DE powerline  7 
SINUMERIK 840Di   1 
SINUMERIK 840DiE (export version) 1 
SINUMERIK 810D   3 
SINUMERIK 810DE (export version) 3 
SINUMERIK 810D powerline   7 
SINUMERIK 810DE powerline              7  
with operator panel types OP 010, OP 010C, OP 010S, OP 12 or OP 15  
(PCU 50, PCU 70) 
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Notes 
The following notes with special significance are used in the documentation: 

 

 Note 

This symbol always appears in this documentation to draw your attention to 
further information relevant to the subject in hand. 

 

! Important 

This symbol always appears in the documentation when important information is 
being conveyed. 

 

 
Additional ordering options 

Appears in the documentation whenever a described function is not contained in 
the standard version but may be ordered as an option. 

 

 

Warning notes 
The following warning notes with graded degrees of importance are used in this 
documentation: 

 

!  
Danger 

Indicates an imminently hazardous situation which, if not avoided, will result in 
death or serious injury or in substantial property damage. 

 

!  
Warning 

Indicates a potentially hazardous situation which, if not avoided, could result in 
death or serious injury or in substantial property damage. 

 

!  
Caution 

Used with the safety alert symbol indicates a potentially hazardous situation 
which, if not avoided, may result in minor or moderate injury or in property 
damage. 
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 Caution 

 
 

 Notice 

Used without the safety alert symbol indicates a potential situation which, if not 
avoided, may result in an undesirable result or state. 

 

 

Technical information 

Trademarks 

IBM® is a registered trademark of the International Business Corporation. 
MS-DOS® and WINDOWS™ are registered trademarks of the Microsoft 
Corporation. 
 
 

Data activation criteria 
The criteria (e.g. after Power On or Immediately) for activating data (e.g. machine 
data) after they have been edited must be noted. The relevant criterion is therefore 
always specified with the data. 

 
� 
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1.1  Product features 
The installation and service tool SinuCom NC provides a simple way of installing 
SINUMERIK 840D/840Di/810D. 
On the SINUMERIK 840D/810D the tool is started from the PG/PC in online mode 
(PG/PC control via the OPI interface), in the case of the SINUMERIK 840Di it is 
included in the software. 
 

Product components 
The installation/service tool SINUMERIK SinuCom NCcomprises four tools:  
1. SinuCom NC: Commissioning Tool for controls SINUMERIK 840D/840Di/810D. 
2. SinuCom FFS: Tool for generating SINUMERIK NC image files for the PC card 

of the NCU/CCU. 
3. SinuCom ARC: Tool for editing SINUMERIK HMI archives (successor of 

ARCEdit). 
4. SinuCom PCIN: Tool for data transfer between the PC/PG and the control. 
 

SinuCom NC 
The Commissioning Tool SinuCom NC offers the following functions: 
• Dialog-based parameterization of machine data (online linked up to the NC) 
• Management of series start-up files 
• Data exchange 
• Option manager 
 

 Note 

The NC card is programmed with standard tools (e.g. Cardware) that are not 
contained in the included in the scope of supply of SinuCom FFS. 
 

 
A Flash File System (FFS) is comparable with a DOS data medium, e.g. a diskette. 
Before data can be archived, the system must be formatted. Then the directory 
structures can be created and files stored in a suitable format. 
The data medium is an electrically erasable PROM (EEPROM). This means that 
before writing the relevant sector must be erased. Algorithms written for the module 
identification are required for erasing and writing. They largely determine the speed 
with which data are written. 
An FFS system can be  read directly from DOS/WINDOWS. 
Because the NC system software also stored on the NC card does not exist in FFS 
format, this can only be performed with SINUCOPY-FFS. 
 

 Note 

Please read the A&D software marketing guidelines before duplicating software. 
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SinuCom ARC for SINUMERIK HMI archive 
With service tool SinuCom ARC you can 
• read 
• delete/insert and 
• change (if data can be edited) 
HMI archive files (e.g. series installation files) in online/offline mode.  
 
 

SinuCom PCIN for data transfer  
With the service tool SinuCom PCIN you can  
• read data (e.g. installation data) to and from the PC/PG and the control via the 

RS-232 serial interface, 
• transfer data safely, 
• set the parameters for the RS-232 interface,  
• edit archive files, 
• store files from directories singly,  
• request the status of the RS-232 interface.  
  
 
The service tool SINUCOM PCIN can be operated with the mouse or keyboard. 
 
 

1.2  Scope of supply 
With HMI SW 6.4 (HMI Advanced) and higher, the installation/service tool 
SINUMERIK SinuCom NC is available with the following components: 
• SinuCom NC: Commissioning Tool for controls SINUMERIK 840D/840Di/810D 
• SinuCom FFS: Tool for editing SINUMERIK NC image files (supersedes 

Sinucopy) 
• SinuCom ARC: Tool for editing SINUMERIK HMI archives (successor of 

ARCEdit) 
• SinuCom PCIN: Tool for data transfer from PC/PG to control (supersedes 

PCIN) 
• Online Help  
 

Licenses 
The following licenses are available: 
• Single license 
• Copy license 
• Maintenance service 
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Supply medium 
The Commissioning Tool SINUMERIK SinuCom NC is supplied on CD. 
 

Foreign languages 
The Commissioning Tool SINUMERIK SinuCom NC is supplied in five languages 
(English/German/Frensh/Spanish/Italian). Language switchover only takes effect 
after rebooting. 
 

Ordering data 
Table 1-1  
Ordering data Order No. 
SinuCom NC 
Installation/Service tools 
on CD-ROM including 
SinuCom FFS, SinuCom ARC, 
SinuCom PCIN, documentation 
Languages English/German 

6FC5 250-  AY00-  AG  

License       
• Single license, current SW version ...............- 0 ........- 0 ...... 0
• Single license, particular software 

version 
...............- � ........- � ...... 0

• Copy license ...............- 0 ........- 0 ...... 1
Software maintenance      

• Software maintenance service ...............- 0 ........- 0 ...... 2
• Order updates separately, particular 

SW version 
...............- � ........- � ...... 3

 
Example for a particular software version, e.g. SW 6.3: 6FC5 250-6....-3... 
 

1.3  Permissible PC platforms 
The product components of SINUMERIK SinuCom NC can be used on the 
following PC platforms: 
 
Table 1-2  

SW Windows 
95 

Windows 
98 

Windows 
ME 

Windows 
2000 

Windows 
NT 

Windows 
XP 

SinuCom 
NC  

- - - - Yes Yes 

SinuCom 
FFS 

- - - - Yes Yes 

SinuCom 
ARC 

- - Yes Yes Yes Yes 

SinuCom 
PCIN 

Yes Yes Yes Yes Yes Yes 

 
 
 

� 
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2.1  Installation variants 
The installation/service tool SINUMERIK SinuCom NC includes four different 
installation variants: 
 
1. SinuCom NC only 
2. SinuCom FFS only 
3. SinuCom ARC only 
4. SinuCom PCIN only 
 
 

2.2  Installation of SinuCom NC 

Requirements 
• The software platform required for SinuCom NC is WindowsNT (Version 4.0, 

Service Pack 6) or Windows XP.  
• SinuCom NC requires about 7MB in the Windows system directory and approx. 

100 MB in the SinuCom NC directory. 
• Before you can install SINUMERIK SinuCom NC you must first close down all 

other applications (not the Explorer). 
 

Procedure 
1. Insert the CD into the CD drive of your PG/PC  
2. Start the Explorer (or an MS-DOS input prompt)  
3. Change to the CD drive.  
4. Start the SETUP.EXE program (in the root directory of the CD). This program 

starts up operator-guided installation of SINUMERIK SinuCom NC. 
5. A system reset of the PG/PC might be performed during installation. Setup of 

SINUMERIK SinuCom NC continues automatically after system reset. 
 
The info files "Siemensd.txt" (German) and "Siemense.txt" (English) are copied into 
the SinuCom NC directory on your hard disk by the SETUP program. So this 
information is still available to you after installation. 
 

Starting SinuCom NC  
SinuCom NC is either started 
• directly from the "Start" menu (task bar)  
• or from "sinucomnc.exe" in subdirectory "BASE" of the SinuCom NC directory. 
 

Establishing a connection to the NC control (OPI)  
Standard configuration: OPI interface X101 of the NC 
The Commissioning Tool SINUMERIK SinuCom NC provides the MPI driver for 
CP5611 for establishing the connection between the NC/PLC and the PG/PC. 
• To parameterize the communication link to the NCK/PLC, select "Target 

system/Establish connection..." 
• If necessary, change the parameterization 
• Restart SinuCom NC.  

The changes you have made in the dialog are now active. 
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 Note 

• In the version as supplied, SinuCom NC has been parameterized for the use 
of the CP5611 MPI driver with the 1.5 Mbaud interface (OPI), the address 
(through which the NC and PLC are addressed from SinuCom NC) is 13.. 

• If you want to use a different interface, please additionally install the relevant 
driver for this module. 

 
 
 

2.3  Installation of SinuCom FFS 

Requirements 
• SinuCom FFS runs under  Windows NT or Windows XP.  
• SinuCom FFS requires approx. 1.2MB  
• Before you can install SinuCom NC you must first close down all other 

applications (not the Explorer). 
 

Procedure 
1. Insert the CD into the CD drive of your PG/PC  
2. Start the Explorer (or an MS-DOS input prompt)  
3. Change to the CD drive.  
4. Start the SETUP.EXE program (in the root directory of the CD). This program 

starts up operator-guided installation of SINUMERIK SinuCom NC. 
5. Select menu "Install SinuCom FFS" 
6. A system reset of the PG/PC might be performed during installation. Setup of 

SINUMERIK SinuCom NC continues automatically after system reset. 
 
The info files "Siemensd.txt" (German) and "Siemense.txt" (English) are copied into 
the SinuCom NC directory on your hard disk by the SETUP program. So this 
information is still available to you after installation. 
 

 Note 

• You can choose any drive name for the OMNI97 device: Enter the drive letter 
in menu "Control Panel/Device Manager/Drives/OMNI97". 

• Windows NT: Enter the drive letter in menu "OmniControl/DriveLetter". 
 

 

Starting SinuCom FFS 
SinuCom FFS is either started 
• via the "SinuCom FFS" icon or the "Start" menu in the task bar of the PG/PC 
• or from SinuCom NC via the menu "Extras\SinuCom FFS".   
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2.4  Installation of SinuCom ARC 

Requirements 
• SinuCom ARC runs under Windows ME, Windows NT (Version 4.0, Service 

Pack 6, and higher), WindowsXP or Windows 2000.  
• SinuCom ARC requires approx. 0.7MB. 
• Before you can install SinuCom NC you must first close down all other 

applications (not the Explorer). 
 

Procedure 
1. Insert the CD into the CD drive of your PG/PC  
2. Start the Explorer (or an MS-DOS input prompt)  
3. Change to the CD drive.  
4. Start the SETUP.EXE program (in the root directory of the CD). This program 

starts up operator-guided installation of SINUMERIK SinuCom NC. 
5. Select menu "Install SinuCom ARC" 
6. A system reset of the PG/PC might be performed during installation. Setup of 

SINUMERIK SinuCom NC continues automatically after system reset. 
 

Starting SinuCom ARC 
SinuCom ARC is either started 
• via the "SinuCom ARC" icon or the "Start" menu in the task bar of the PG/PC 
• or from SinuCom NC via the menu "Extras\SinuCom ARC".   
 
 

2.5  Installation of SinuCom PCIN 

Requirements 
• SinuCom PCIN runs under Windows 95, Windows 98, Windows ME 

WindowsXP, or Windows NT (Version 4.0, Service Pack 6, and higher).  
• SinuCom PCIN requires approx. 1.2MB 
• Before you can install SinuCom PCIN you must first close down all other 

applications (not the Explorer). 
 

Procedure 
1. Insert the CD into the CD drive of the PG/PC  
2. Start the Explorer (or an MS-DOS input prompt)  
3. Change to the CD drive.  
4. Start the SETUP.EXE program (in the root directory of the CD). This program 

starts up operator-guided installation of SINUMERIK SinuCom NC. 
5. Select menu "Install SinuCom PCIN" 
6. A system reset of the PG/PC might be performed during installation. Setup of 

SINUMERIK SinuCom NC continues automatically after system reset. 
 



12.04 2 Installation 
 2.6  Uninstalling 
 
 

© Siemens AG 2004 All Rights Reserved 
SINUMERIK 840D/840Di/810D SYS Commissioning Tool SinuCom NC (INC) - 12.2004 Edition 2-21 

Starting SinuCom PCIN 
SinuCom PCIN is either started 
• via the "SinuCom PCIN" icon or the "Start" menu in the task bar of the PG/PC 
• or from SinuCom NC via the menu "Extras\SinuCom PCIN".   
 
 

2.6  Uninstalling 

Requirements 
• Before you can uninstall SinuCom NC you must first close down all other 

applications (not the Explorer). 
 

Procedure 
1. Start the Explorer (or an MS-DOS input prompt)  
2. Change to directory SinuCom NC.  
3. Start the program DEINSTALL.EXE. 
4. A system reset of the PG/PC might be performed during the uninstall 

procedure. The next time you restart, the installation/service tool will have been 
automatically removed with the SINUMERIK SinuCom NC. 

 
 
 
 
 

� 
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3.1  Installation and start-up with SinuCom NC 

Interactive installation and start-up 
The installation and start-up tool SinuCom NC allows you to install and start up NC 
controls 840/840Di/840D interactively. 
 

Creating a project 
When you perform installation with the tool SinuCom NC  
1. a "project" is created (application window) 
2. a project tree is generated (project window) 
3. in which you can configure functions (parameterization window). 
 

 
Fig. 3-1 Initial display SinuCOM NC (application window) 
 

 
Fig. 3-2 Project tree with parameterization window 
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Projec 
Projects are created and managed in the application window. 
 

Project tree 
The branches of the project tree are the functions to be parameterized, the 
arrangement corresponds to the installation sequence (which must be kept). 
 

Parameterization window  
Data is entered in the parameterization window. The online help is available for any 
queries. 
 

! Important 

When you start SinuCom NC, not only SinuCom NC but also the HMI basic 
system applications MMC 101/102 master control, data cache, MMCEnv, AccVar, 
and arcdrv are displayed in the task bar or task manager. 
These basic system applications are automatically closed when you close down 
SinuCom NC and must not be closed manually, as otherwise SinuCom NC will no 
longer function correctly. 
 

 
 
 

3.2  Help functions 
To ensure that all information that might be required is available during installation 
and start-up, the installation and start-up tool SinuCom NC provides the following 
online Help: 
• Context-sensitive Help dialog box 
• Context-sensitive Help SW functions (DOCONCD) 
• Machine data Help  
• Alarm Help 
• System description SinuCom NC in German and English as PDF (part of the 

Online Help) 
 

Context-sensitive help dialog box 
Call 
• Key combination "F1" or  

• by clicking on the Help icon in the tool bar with the mouse  and then 
clicking into the dialog box or on the control element 

 
For each dialog box or control element a Help screen listing the associated 
machine data is opened.  
If you select a control element (e.g. text field), only the machine data used by that 
control element appear. 
If you click into the background of the dialog box, all the machine data used in the 
dialog box appear. 
 
 



3 General Operating Sequences 12.04 
3.2  Help functions 
 
 

 © Siemens AG 2004 All Rights Reserved 
3-26 SINUMERIK 840D/840Di/810D SYS Commissioning Tool SinuCom NC (INC) - 12.2004 Edition 

Fig. 3-3 Machine data Help 
 

Context-sensitive Help SW functions 
Requirements: 
The CD "DOCONCD" (>= 10.2000) has been inserted into your CD drive and 
installed. 
Call 
The context-sensitive Help for software functions is called up from the context-
sensitive Help window by clicking on the "DOCONCD" button. 
If several Help topics are output, you can select them individually: 
 

 
Fig. 3-4 Context-sensitive Help SW functions: Several Help topics 
 
 

 Note 

If DOCONCD is not installed the button "DocOnCD" does not appear. 
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Machine data Help 
Call 
• Key "F1" or  

• by clicking on the Help icon in the tool bar with the mouse  and then 
clicking into the dialog box or on the control element 

 
For each dialog box or control element a Help screen listing the associated 
machine data is opened. The machine data are sorted numerically in ascending 
order and displayed as a link. By clicking on one of these links you open the 
associated machine data Help. 
The Help dialog remains open until you click on the "Close" button or select 
another dialog (you can select several Help texts). 
 

Alarm Help 
Call 
If alarms occur while you are performing installation and start-up interactively, you 

can start the alarm Help by clicking on the info symbol  with the mouse in the 
alarm line and then clicking on the alarm. 
 
The Help for the alarm in question is opened. 
The Help dialog remains open until you click on the "Close" button or select 
another dialog (you can select several Help texts). 
 

System description SINUMERIK SinuCom NC 
The system description SINUMERIK SinuCom NC is part of the online Help, it 
describes  
• the product 
• the installation 
• handling of SinuCom NC 
• the scope of functions. 
 

"No Help found" 
If no Help can be found for the requested topic, three alternatives are proposed: 
• Start DOCONCD 
• Display the key topic list 
• Open the document "System Description SinuCOM NC". 
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3.3  Using the keyboard 
You can call up the following functions using key combinations: 
 
Table 3-1 Calling up functions with key combinations 

Key combinations Meaning 

"F1" Context-sensitive Help dialog box, call up machine 
data Help 

"<Strg> + F" Open Find dialog box (in expert list only) 
"F3" Find next (in expert list only) 
"<Strg> + Pos1": Jump to the beginning of the table (in expert list only) 
"<Strg> + End": Jump to the end of the table (in expert list only) 
">" or "<" Incremental increase or decrease of value (in expert 

list only) 
"<Strg> + T" Switches between expert list and dialog box view 
 
 
 

� 
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4.1  Document Scope and Supported Systems  

4.1.1 Scope of this Manual 
 
This version of the manual supports SinuCom NC Version 06.04.  For other 
versions of the software, please consult the corresponding manual. 
 
 

4.1.2 Supported Systems and NCK Versions 
SinuCom NC supports the following SINUMERIK controls: 
• 840D 
• 840Di 
• 810D 
 
NCU V51.01.22 or newer is required. An appropriate warning is output if the 
machine data server from SinuCom NC is started on older NCK versions. 
Furthermore, SinuCom NC outputs various error messages when operated on 
older NCK versions because these versions are not fully supported. 
 
SinuCom NC Resource Displays requires NCK V51.08 or newer. No alarm will 
occur on older versions.  The feature will simply not be there. 
 
SinuCom NC Trace supports IPO signals for NCU V05.03.37 or newer. 
 
SinuCom NC Trace supports full Trace of IPO servo and PLC signals for NCU 
V06.04.15.00. 
 
SinuCom NC SI Acceptance Test is supported for NCU V06.04.15.00. 
 
SinuCom NC is compatible with HMI-Advanced for HMI-Base V06.03.14 with Patch 
06.03.15 (and newer versions). 
 
SinuCom NC is not compatible with HMI-Advanced for HMI-Base V06.02 or older. 
 
 

4.1.3 Supported Languages 
SinuCom NC supports the same languages as SINUMERIK. The language setting 
can be accessed by clicking "Tools" on the main menu. 
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4.2  Installation and Operation 

4.2.1 Installation Requirements 
SinuCom NC V06.04 requires one of the following, and cannot be run on any other 
platform: 
• Windows® NT Version 4.0, Service Pack 6 or 6A 
• Windows® XP professional SP1. 
 
SinuCom NC occupies approximately 7MB in the Windows® system directory and 
approximately 50MB in the SinuCom NC directory. 
 
 

4.2.2 Installation of SinuCom NC 
Before installing SinuCom NC, all applications except Windows® Explorer must be 
closed.  To install SinuCom NC, place the CD in the CD drive of the PG/PC. If the 
install does not start automatically, start Windows® Explorer (or MS-DOS) and 
change to the CD drive.  Then start the program SETUP.EXE, which is located in 
the root directory of the CD. 
 
During the installation, a warm restart may be required on the PG/PC. The 
SinuCom NC SETUP continues automatically after this warm restart.   
 
The "read me" files "siemensd.txt" and "siemense.txt" are copied by SETUP into 
the SinuCom NC directory on the hard disk.  
 
 
 

4.2.3 Installation of Trace Server Only ("Standalone Trace") 
 
 
 

4.2.4 Communication to the NCK / PLC 
The "Parameterize connection..." dialog is used to configure the NCK and PLC 
connection. This dialog can be accessed from "Target Syst." in the main menu.  It 
is available for configuring the communication link to the NCK/PLC, including the 
selection of one of the following MPI drivers that are provided: 
• CP5611 (default, for use with 1.5 Mbaud interface [OPI]) * 
• CP5511 
• CP5512 
 
The address must be set to "13" for this default configuration. 
 

 Note 

If a different interface is used, its drivers must be obtained and installed 
separately (e.g., from SIMATIC Software). 
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 Note 

Changes in this dialog become effective only after SinuCom NC has been 
restarted. 
 

 
 

4.2.5 Starting SinuCom NC 
SinuCom NC can be started in one of three ways: 
• from the "Start" menu on the Windows® task bar. 
• by executing sinucomnc.exe, (found in the "base" sub-directory of the SinuCom 

NC directory). 
• a softkey on the HMI Advanced (if so configured). 
 

 Note 

On 840Di, the 840Di software is usually installed before the optional HMI 
Advanced software. In this case, SinuCom NC will not automatically be installed 
on softkey 9. To make this softkey operational, SinuCom NC must be reinstalled 
after the complete installation of the 840Di software. 
 

 
SinuCom NC can be run without a mouse by using a keyboard; however, SinuCom 
NC Trace and SinuCom NC SI Acceptance Test require a mouse. 
 
 

4.3  Main Menu 
The SinuCom NC main menu is, for the most part, self-explanatory. Rather than 
listing the functions here that it provides, it is suggested that the user view the 
selections directly in the product. Non-obvious selections will be addressed in 
context elsewhere in this manual. 
 

 Note 

Some menu choices might be permanently grayed out. These menu choices will 
be used in the future to support features such as Offline SinuCom NC. 
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4.4  Toolbar Buttons 
Find in 

 

This button displays a dialog that allows the operator to 
search for variable names by character string.  The variables 
can be filtered to display subsets such as "All Data", "General 
Data ONLY", "Axis Data ONLY", "Channel Data ONLY", and 
"Drive Data ONLY". 
 

 
Info 

 

If the Machine Data is being displayed (either in Dialog View 
or in the Expert List), this button displays the Machine Data 
version.  If not in a Machine Data display, the SinuCom NC 
version is displayed.  
 

 
 
Help (context 
sensitive) 

 

This button is available if context-sensitive help is available.  
Clicking the button and then clicking a dialog or control 
element opens a Help window.  If a control element is 
selected (e.g., a text field), only the machine data used by 
that control element appear.  If the background of a dialog 
box is clicked, all the machine data used in the dialog box 
appear. 

 
 
Open 
Connection 

 

This button open the connection to the NCU 
 

 
Close 
Connection 

 

This button closes the connection to the NCU  
 

 
Online Project  

 

This button places the project online and displays a check 
mark next to "Online Project" in the drop-down menu  
 

 
 
 

4.5  Alarm Messages 
When an alarm occurs, the alarm display area appears near the top of the screen.  
The most recent alarm appears in the alarm text window, which is a drop-down list 
that expands to display the most recent alarms.  If an alarm can be selected, 
followed by a click on the information button.  This provides detailed alarm 
information in the form of a PDF file (definitions, reactions, remedy, and program 
continuation data).  The "Alarm Log" button provides chronological alarm data.  
The "Alarm Remedy" button can be used to guide the user through the process of 
eliminating the alarm. 
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4.6  Context-Sensitive Help 
If available, context-sensitive help can be obtained: 
• for the dialog or element in focus by pressing "Shift" and "F1", 
• using the "Help" button.  
 
 

4.7  DocOnCD Help 
If DocOnCD Version 10/00 or higher is installed, it can be accessed through: 
• the "Help" button in the dialog,  
• the "?" main menu selection, then "DocOnCD" 
• the DocOnCD button in the context-sensitive Help. 
 

4.8  Machine Data ("MD") 

4.8.1 Viewing and Configuring MD 
Machine data can be viewed in either the Dialog Display (default) or the Expert 
List. The Dialog Display provides better navigation and grouping of data points 
(valuable for the novice) while the Expert List provides a higher density of data on 
the screen. The user can toggle between these two display types with "Ctrl + E", or 
from the "View" menu. 
 
The MD Server is started from the project tree (left side of screen) with a machine 
data block. To do this: 
• Select "Open Online Project" from either its toolbar button or from "Target Syst." 

in the main menu. 
• Expand the SINUMERIK folder, click on "MD Block", then double-click on the 

"MD-Block 1" icon. 
• Click on any element shown under MD-Block 1 in the tree to display or change 

that element's configuration. 
 

 Note 

The units displayed depend on the system of units selected. 
 

 
 

 Note 

Variables that have a white background can be changed.  Those that have a gray 
background are read-only. 
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The Dialog Display: 
When a folder is selected, the first level dialog is displayed.  When a dialog within 
the folder is selected, the data associated with that dialog is read out of the NC. 
 
When the buttons "Channel +" or "Channel -" (or "Axis +", Axis -", etc.) are clicked, 
the dialog with the data of the next/previous channel is selected.  After an NCK 
reset (warm restart) the project tree and the dialog display are regenerated.  When 
the dialog is exited, the displayed status data is written to the NC.  
 

 Note 

On single-channel systems the structure view does not contain any channel 
folders. The axis-specific dialogs are then located directly below the control 
folder. 
 

 

The Expert List 
All configuration that can be performed with the Dialog Display can also be 
performed using the Expert List. The difference is in presentation. The tabular 
structure of the Expert List offers the experienced user a considerable amount of 
flexibility without the guiding presence of the Dialog Display. 
 
Right-clicking on the Expert List brings up a context-sensitive menu of tools for 
working with the list. These tools are also available from the "View" selection in the 
main menu. 
 
 
To assist in searching, four separate Expert List MD ranges can be can be 
accessed from the project tree: 
• General MDs 
• Channel-specific MDs  
• Axis-specific MDs 
• Drive MDs. 
 
The following key combinations can be used to find and position within the Expert 
List: 
Tabelle 4-1  
F1 Opens the Help for the selected machine data 
Ctrl + F Opens the "Find" dialog box 
F3 Find next 
Ctrl + Home Jump to the beginning of the table 
Ctrl + End Jump to the end of the table 
 

 Note 

Corellation between any MD number and its description can be determined 
through use of the "Find In Dialog" in the editing menu, or by pressing Ctrl + F 
from the Expert menu. 
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The "<" and ">" keys can be used to make 10% increases and decreases in the 
values. 
 
The color and font of the title, values, table, and status bar can be accessed by 
selecting "Tools" from the main menu, then "Settings", then "Expert List". The 
settings take effect immediately and are not lost when the system is restarted. 
 

Changing and Activating MD 
Effecting a modification in a machine data item is a two-step process: 
• change the item 
• activate the item 
 
To change a Machine data item: 
• (Display Dialog only) If a "Change" button is available, press it to begin the 

change. 
• Place the cursor in the field, or select a drop-down menu. 
• Key in or select the desired data. 
• (Expert List only) press "Enter" to complete the change. 
 
To activate the change, the specific action is described in the toolbar must be 
executed (e.g., NCK Reset).  
 
 

4.8.2 Machine Data Project Tree 

Options 
This dialog allows installation of purchased control options, and the associated 
upgrade of the license key.  User guidance for obtaining a license key via the 
Internet is also available here. 
 

Trace Setup Wizard 
See chapter "Trace Setup Wizard" more information on the Trace Setup Wizard. 
 

Drive Bus Configuration 
This dialog allows configuration of the drives on the machine. 
 

Channel Mode Group Assignment 
This dialog allows channels to be assigned to a given mode group, or to no mode 
group.   
 

Axis Data 
This extensive dialog allows configuration of the overall complement of machine 
axes as well as a wide variety of attributes for the individual axes on the machine.  
It is important to note that the drives for the axes are also setup in this area. 
 



4 SinuCom NC: Functions 12.04 
4.8  Machine Data ("MD") 
 
 

 © Siemens AG 2004 All Rights Reserved 
4-38 SINUMERIK 840D/840Di/810D SYS Commissioning Tool SinuCom NC (INC) - 12.2004 Edition 

Axis Couplings (Functions) 
This dialog allows the configuration of coupled axes.  It is only visible when one of 
the following control options is set: 
• Gantry Axes 
• Master-Slave Coupling 
• Synchronous Spindle 
 

Measure (Functions) 
This dialog is used to set the electrical polarity of each connected sensor (probe).  
 

Protection Zones (Functions) 
The Protection Zones dialog is used in setting the number of files for machine- and 
channel- related protection zones. 
 

Resource Displays (Functions) 
This feature is new for SinuCom NC V06.04.  NCK V51.08 or newer is required. 
 
There are four categories of Resource Displays.  They can be accessed from the 
Functions folder in the Machine Data Project Tree: 
• Clock Rates 
• Memory 
• DRAM 
• SRAM 
 
Since these resources are MD variables, they can be viewed and changed as 
described in the section entitled "Machine Data" starting. 
 
Detailed descriptions and rationale for modification of specific Resource Display 
parameters  is beyond the scope of this manual.  For additional information, 
contact Siemens Support. 
 

Clock Rates 
The cycle times and burden on the NCU are displayed so the user can estimate the 
system basic clock rate and the interpolator clock factor. 
 
Data is displayed for Clock Rates of all channels and for individual Channel Clock 
Rates.  If individual Channel Clock Rates are selected, a drop-down list is 
displayed to select the channel.  See the actual display for the specific parameters. 
 
Field updates are started and stopped via the "Start" and "Stop" buttons. 
 

Memory 
This function allows the user to allocate the total user memory space for the 
following two types of RAM: 
• Static (SRAM) - data needing to be retained (e.g., configuration data). 
• Dynamic (DRAM) - data not needing to be retained (e.g., current axis position). 
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DRAM and SRAM 
These functions allow a piecewise allocation of memory as described by the 
Resource Display screens provided.  (See the specific screen for the actual 
variables that can be configured.)  These memory areas are set to reasonable 
default sub-areas during a general NCK reset.  To use the user memory optimally, 
these areas can be adapted by the user by changing the relevant machine data 
items.  This memory configuration comes into effect after an NCK reset. 
 
 

4.8.3 Service Data 
The Service Data Display is opened by clicking "Diagnose" in the main menu, then 
"Service Data".  The Service Overview page gives an indication of the overall 
health of the axes and drives on the machine. The "Axis" display shows the actual 
and setpoint values for key axis and drive parameters. 
 
 

4.9  Archiving 
An archive is a backup of configuration data. The default path for archiving files is 
the same as that of HMI Advanced. 
 
An archive: 
• can be manually commanded through the SinuCom NC File menu.  (This is 

recommended prior to making configuration changes so that a error recovery 
can be achieved.) 

• can be required by the system when a change has been made to the NCK that 
requires memory reorganization. (The message "NCK Reset Required" is 
presented, and an archive is performed during the subsequent reset.) 

 
For similar machines, a standard archive can be read in immediately after the 
installation and first startup of SinuCom NC. 
 

Creating an archive 
1. Click "File", "Archive", then "Create...".  The "Create archive" dialog appears. 
 
2. Select one of the following archive choices: 

• Data management 
• File system 

 
3. (840D only) Using the "radio" buttons, select whether the file should be of type: 

• "Series Startup" (binary) 
• "Upgrade" (ASCII) 

 
4. Using the "radio" buttons, select the archive content (NC [with or without 

compensation], PLC and/or MMC data.) 
 
5. Click the "Next" button. 
 
6. At the prompt, enter the desired name and path of the .arc file. 
 
7. Click the "Finish" button to complete the operation. 
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Reading In an Archive  
1. Click "File", "Archive", then "Read In...".  The "Read in archive" dialog appears. 
 
2. Select one of the following archive choices: 

• Data management 
• File system 

 
3. Click the "Next" button. 
 
4. At the prompt, enter a file name. 
 
5. Click the "Finish" button to complete the operation. 
 
 
 
 

4.10  SinuCom NC Trace 

(for SinuCom NC Version 06.04.01) 

 Note 

SinuCom NC Trace uses several unique terms. To better understand the 
descriptions in this section, please review the Appendix entitled "Abbreviations 
and Definitions - SinuCom NC Trace". 

 
 

Definition and Use 
SinuCom NC Trace (also simply called "Trace" in this document) is a SinuCom 
NC facility that can dynamically record data from the NC, drives, PLC, or HMI. 
Once recorded, this data can be graphically displayed in a form similar to that of an 
oscilloscope or logic analyzer, printed, or saved to a file. Saved files can be loaded 
into Trace for viewing at a later time, even on a different machine. 
 
Trace can be used to assist machine manufacturers, end users and Siemens 
service personnel in activities such as: 

• Trouble-shooting and debugging 
• Machine performance analysis, benchmarking and tuning 
• Process performance analysis, benchmarking and tuning 

 

Compatibility with Siemens Software 
NCK – Version 05.03 or 06.03 (basic functionality). 
NCK – Version 06.04 or later (extended functionality). 
 

 Note 

The level of available Trace functionality is automatically determined when the 
NCK version is detected at startup. 
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Compatibility with Microsoft Windows® 
Trace is a Microsoft Windows® application. It runs on a standard Windows-PC 
platform under one of the following operating systems: 
• Windows® NT 4 SP6 with Internet Explorer 5.0 or later 
• Windows® XP 
 
Common Windows® controls such as scroll bars, toolbars, tabbed dialogs, etc., are 
used. A mouse or other pointing device is required for selecting, dragging, etc. 
 

Trace’s Relationship to SinuCom NC 
Trace can be started from SinuCom NC by selecting the Trace menu item from the 
"Diagnosis" menu. If a Trace session is already active in the NCK when this menu 
item is selected, SinuCom NC switches to the active Trace session. 
 
Trace runs as a separate executable (.exe file) in its own application window.  This 
means that Trace has its own set of menus that do not integrate into the menus of 
SinuCom NC. These Trace-specific menus are described in chapter "Toolbars and 
Menus". 
 
 

4.10.1 Overview: How Trace is Used 
Typically, Trace is used to record data (signals) shortly before or after an event.  To 
do this, the following sequence can be executed: 
 
1. Specify what signals to record. 
2. Specify when to start and stop recording (can involve the definition of a trigger 

condition). 
 

 Note 

A mode of operation called “endless collection” can be enabled by simply not 
specifying a stop condition.  (I.e., the recording process continues until it is 
stopped manually.)  This mode operates like a strip chart recorder.  Instead of 
printing on paper, however, when the data storage area becomes full,  the oldest 
data is discarded to make room for the newest.  (I.e., the data is stored in a 
“circular buffer”.) 
 

 
1. Start the recording process by arming the trigger. 
2. The "Awaiting Stop" message is displayed until data collection stops.   
3. Note  

If it is desirable to view waveforms as the data as it is collected, the user can set 
"Keep Data on NCK" off. 

4. View the resulting waveform(s). 
5. Manipulate the waveform(s) as desired to examine details (e.g., zoom, scroll, 

etc.). 
6. Optionally, print the waveform(s) or save to a file. 
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 Note 

Siemens or the machine builder can supply setup files that are pre-configured for 
certain tasks such as troubleshooting or performance analysis. 
 

 

A Hands-On Example: 
The easiest way to learn about Trace is to actually use it. This section illustrates 
the basic use of the tool in step-by-step fashion. 
 
1. Activate SinuCom NC. 
 
2. Click "Diagnosis" in the SinuCom NC main menu. 
 
3. Click "Trace" in the Diagnosis menu. The Trace initial screen will appear. 
 

 Note 

A yellow (or red) message banner (in this case containing "No Waveforms") is 
displayed at the top of the graph window. This box can optionally appear 
whenever a graph window is displayed.  It can contain such messages as:  
• "No Waveforms" – No waveforms have been defined ("added") for display. 

 
• "No Waveforms Shown" – All defined waveforms have had their "Show" 

checkbox unchecked, see Figure 4-2. 
 
• "Awaiting Stop" – Recording is in process, and the checkbox "Keep data on 

NCU until stopped" has been checked (default setting), see Figure 4-5. 
 
• "Trace Data has been Lost.  Total Segments (x)" – Where "(x)" is the 

number of segments lost. (See "Hide Dropouts / Show Dropouts" for 
additional information on lost data.) 

 
 
4. Right-click anywhere in the graph window to bring up the "Graph Window 

Context Menu". 
 
5. Click the "Add Waveform..." menu item. The "Add Waveform" screen will 

appear. 
 
6. In the field labeled "Containing:", type "actime". On the right of the screen, three 

candidates that have this character string in their names are presented.   
 
7. Click the name "acTime" (top selection) to highlight the line it is on. 
 
8. Click the "Add" button.  The signal is now ready to be recorded.   
 
9. Click the "Close" button. A graph window will appear without a waveform but 

with axis labels and a tab for the new waveform. 

10. Click the "Start Trace" icon ( ). The "Trace Status" will change from 
"Stopped", to "Ready", to "Recording".  Data recording is now in process. 



12.04 4 SinuCom NC: Functions 
 4.10  SinuCom NC Trace 
 
 

© Siemens AG 2004 All Rights Reserved 
SINUMERIK 840D/840Di/810D SYS Commissioning Tool SinuCom NC (INC) - 12.2004 Edition 4-43 

11. After a short period of time, click the "Stop Trace" icon ( ).  The waveform 
representing the collected data will be drawn. 

 
12. The figure below is an enlargement of the lower left corner of the display.  Click 

the "Fit Height to Window" and "Fit Time to Window" icons to show the entire 
waveform at its maximum size. 

 
Scroll down

Compress Y

Expand Y
Fit Height to
Window

Fit Time to 
Window Expand X

Compress X
Scroll Left

 
Figure 4-1 Scale and Scroll Icons 
 
The entire waveform is now shown at its maximum size. The plot is either a 
diagonal line or a sawtooth. 
 

 Note 

The scale of the observed waveform will vary because of the data limit, sampling 
rates and amplification that had previously been set. Y axis scaling will vary de-
pending upon when "Start Trace" and "Stop Trace" are clicked. Also, the variable 
"acTime" is a continuously running clock that can roll over to zero. It also restarts 
at the beginning of each block. This might cause the waveform to appear as a 
sawtooth. 
 

 
The above example is intended to be an introduction to the Trace function. Review 
of the remainder of the material in this section, and further work with Trace, will 
allow discovery of a variety of additional capabilities. 
 

Passwords 
Certain functions of Trace require use of a password: 
 
• Variable Selection – Some variables are available for selection only at 

approved password levels. If the appropriate password has not been entered, 
certain variables will not be displayed, and thus cannot be recorded. 
 

• Functions – Some functions are available only at approved password levels.  
(e.g., selecting signals by address rather than by name). 
 

• Sessions – The creator of a session can make the session read-only or 
password-accessible. (E.g., a session intended for troubleshooting might be 
executable by an operator, but its setup can be modified only by a technician.). 
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Recording Basics: Data and Events 
There are two main aspects of recording: 
• The Data aspect (i.e., what to record, sometimes called the “signal”) 
• The Event aspect (i.e., when to record, on a per-point basis) 
The Data aspect can be selected as subsets of the following main types of data: 
• All NC variables (axis data, drive data, channel data, etc.) 
• Some PLC data 
 
The data is usually selected by name, but can also be selected by address (see the 
Chapter: Dialogs, Dialog: Setup Waveforms) .Note that some types of data require 
further qualification of the signal. (E.g. "axis data" must also have the specific axis 
defined.) 
 

 Note 

“Event-Only” is a special case in which no data is recorded. Only the occurrence 
of the event is recorded. 
 

 
The Event aspect requires that an "Event" be selected for each waveform.The 
following list shows three examples of these Events: 
 
 
 Events – Partial List 
 
Interpolation Cycle (IPO Cycle) IPO interpolation cycle 11  
   ... 
   ... 
Prot File Begin start logging 
   ... 
   ... 
Block Begin S1 block start, w/o intermediate blocks,  
 (all program levels) (preprocessing) 
   ... 
   ... 
 
A drop-down menu of all Events is made available when the Event field for the 
session's first waveform is selected. The selected Event for the first waveform will 
either be a "preprocessing" or a "non-preprecessing" Event. Within a given 
session, all Events must be either preprocessing or non-preprocessing. To ensure 
this continuity, the system will present only the appropriate Events (preprocessing 
or non-preprocessing) for subsequent waveforms. 
 
 
 

                                                           
1 Events designated as “cyclic” occur repetitively at a constant rate.  Waveforms for data re-
corded on non-cyclic events have special features and different behaviors as described else-
where in this manual. 
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4.10.2 Sessions and Their Content 

Sessions 
A Trace Session is an environment constructed for the purpose of collecting data. 
This data can be used to display one or more waveforms in a configurable manner. 
The setup (configuration) and the "trace status" (e.g. stopped, recording, no 
waveform, etc.) are attributes of a session. (I.e., at any given time, a session has a 
single setup and a single status, independent of other sessions.) 
More than one session can exist simultaneously.  Any or all existing sessions can 
be operated, and can record independently. A new session can be created at any 
time (assuming memory, disk space, resources in the NCK, etc., are available).  
For example, one session can be recording a set of signals while the second 
session is waiting for a trigger condition. 
When the recording process is manually started or stopped (i.e., by clicking the 

"start trace" button, , or the "stop trace" button, , on the toolbar ), only the 
active session is affected. (The active session is the session that is currently 
displayed.) Likewise, when a setup is changed, only the active session is affected. 
 
Typically, a session is created by clicking "New Session..." in the file menu. In a 
future release, a session will also be able to be created by instructions in the NC 
part program (also called “batch mode”). Session data will be recorded and viewed 
the same way regardless of which method was used to create it. 
 
See also in the Chapter: "Toolbars and Menus", "Open Sessions…0" and "Close 
Sessions…", for file maintenance information, including information on Preserved 
Sessions. 
 
 

Graph Windows 
A graph window is the area of the screen where the acquired data is displayed as 
one or more waveforms. More than one graph window can be displayed, but 
waveforms in all graph windows must be drawn from the same set of recorded data 
(within a session). Multiple waveforms can be combined and overlaid in each graph 
window. 
 
Example: Below, shows relationships among four recorded waveforms. Waveforms 
1, 2 and 4 are displayed in the upper graph window while waveforms 2 and 3 are 
displayed in the lower graph window. (Note that a 5th waveform exists but has not 
been selected for display.) Each graph window can be maximized, minimized, tiled 
or cascaded according to the normal conventions of Microsoft Windows®. 
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Bild 4-2 Multiple Graph Windows (tiled horizontally) 
 
Each graph window can have a user-defined title. All settings described in this 
section are independent for each graph window. Each graph window can be 
manipulated in the following ways: 
 
• The focus of the graph window determines which of the displayed waveforms 

is ready for manipulation. The focus can be changed from one waveform to 
another by clicking the associated colored tab, or by clicking the waveform 
itself. The colored tab can be configured to show either the waveform number, 
or the waveform description/name (as in "Graph Window 1" in Figure 4-2., 
above). The waveform that has focus is indicated in the colored tabs by a 
change in coloration.. 
 

• Focus can be applied to more than one waveform at a time by holding down 
the CTL key when clicking another waveform or tab. This feature is useful for 
performing the same manipulation on multiple waveforms at once for 
operations such as drag, resize, show/hide, remove, and cut/copy/paste. When 
two waveforms have focus, tick marks and Y labels will appear for both 
waveforms at the same time. When more than two waveforms have focus, tick 
marks and Y labels will appear for only the last two waveforms selected. 

 
• A show/hide checkbox is used to “show” or “hide” the waveform that has focus. 

When the box is checked, the waveform that has focus is made visible and its 
tab is shown in color; when the box is not checked, the waveform that has fo-
cus is made invisible and its tab is gray. 
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 Note 

More than one waveform can have focus at the same time. If this is the case, the 
paragraph above applies to all waveforms that have focus. 
 

 
• X and Y Axis labels are the numbers displayed next to the ticks marks. They 

pertain to the waveform that has focus. These labels change automatically with 
panning, zooming or change of scale. Numeric resolution (number of decimal 
places) can also be selected. 

 
• The vertical scroll bars can be clicked or dragged to scroll the off-screen 

portions of the graph window into view (i.e., according to the normal 
conventions of MicroSoft Windows®). The specifics of scrolling and scaling are 
as follows: 

 
• The horizontal scroll bar is shown as a miniature image of the entire 

waveform.(see Figure 4-2) This bar can be moved or dragged just like a 
standard Windows® scroll bar. Additionally, a rectangle is superimposed onto a 
portion of the bar which corresponds  to the portion of the waveform that is 
being displayed. This rectangle can be stretched to change the horizontal 
scaling. 

 
• Along the vertical and horizontal scroll bars, there are buttons to incrementally 

stretch or shrink the scaling of the axes.  Alternately, the vertical and horizontal 
axes can be dragged to stretch or shrink the scaling.  Also, the "Fit Height to 
Window" and "Fit Time to Window" buttons can be used to force the entire 
waveform into view. (See figure "Scale and Scroll Icons") 

 
• After selecting "Zoom X and Y" from the View menu, a portion of the waveform 

can be "boxed" (i.e., left mouse button down, then drag, then left mouse button 
up) in order to zoom to that section (see  the Chapter: Toolbars and Menus, 
Menus: View, for details pertaining to the zoom function.) 

 
Other aspects of the graph window can be configured, such as graph style, grid 
lines, scaling style, etc.  (See "Dialog: Setup Display“ for details.) 
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4.10.3 Reference Waveforms 
An understanding of the following terms will be beneficial in understanding this 
section: 
 
Waveform – Any single graphical plot of a series of recorded data points. 
 
Standard Waveform – A waveform that is updated with new data when the record 
button is clicked. 
 
Reference Waveform – A static waveform that is created from an existing 
waveform (standard or reference).  This waveform type is NOT updated with new 
data when the record button is clicked. 
 
Copy (a waveform) – The process of selecting a waveform and placing a duplicate 
on the Windows® clipboard.  Such a waveform can subsequently be pasted into a 
SinuCom NC Trace Session. 
 
Insert (a waveform) – The process of placing a duplicate of a waveform from one 
session into another session. 
 
Load (a waveform) – A waveform characterization process that is executed during 
the opening of a session file.  Waveforms can be loaded as either "Standard 
Waveforms" or "Reference Waveforms". 
 
 
A reference waveform can be displayed alongside freshly recorded data, (e.g., to 
be used as a baseline reference or for comparison to a known data signature).  
 
Reference waveforms have many of the characteristics of standard waveforms, 
and can be manipulated similarly; however, they differ in the following important 
ways: 
 
• They have an "R" prefix before their numeric designation to distinquish them 

from standard waveforms.  They are also drawn with a dashed line. 
 
• Their data and display remains unchanged when a new recording session 

begins.  (I.e., their data is not updated during a recording session.) 
 
• They can be repositioned horizontally (e.g., to synchronize them with 

waveforms recorded at a different time.) 
 
• They can be created from an existing waveform that has recorded data, either 

by "copying" a waveform in the current session or by "inserting" a waveform as 
reference from another file. 
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Creating Reference Waveforms 
There are three ways to create a reference waveform: 
 
1. by "Copy Waveform / Paste Waveform as Reference".  (Note that copy from 

session-to-session is supported.) 
 
2. 2) when opening a session file, by designating one or more waveforms as 

reference (via checkbox). 
 
3. 3) when "Inserting" (i.e., "appending") an existing session file, by designating 

one or more waveforms as reference (via checkbox). 
 

 Note 

Any waveform that had been previously saved without data can only be loaded as 
a standard waveform. 
 

 

 Hinweis 

Edits to waveforms can result in one or more waveforms that consist of individual 
signals with and without collected data (e.g., non-cyclic signals with the "Same Y" 
Plot Y option). If an edit creates a waveform with incomplete data, all recorded 
data for that waveform will be discarded. 
 

 

Manual Alignment of Reference Waveforms ("Dragging") 
A reference waveform can be dragged horizontally to visually synchronize it with 
data captured at a different time. This dragging applies to the display of that 
waveform in all windows. 
 

 Note 

When either a reference or live waveform is hovered over, a directional arrow 
cursor will be displayed that shows the direction(s) in which dragging is allowed. If 
no dragging is allowed, a padlock cursor is displayed. 
 

 
Horizontal dragging is enabled only if none of the following conditions are true: 
 
• a zoom tool is selected.  (Waveform can be dragged again after the zoom 

operation is completed.) 
 
• a trace is being recorded. 
 
• an annotation is being dragged. 
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Dragging Facts: 
 
When a reference waveform is dragged, it "tears off" from its original position (i.e., 
a faded dotted original waveform is left behind). 
 
Both a numeric absolute position and a delta position are displayed in real time in 
the graph window during the dragging process. 
 
The original waveform and the position data are removed from the display when 
the mouse button is released. 
 
While the mouse button is still depressed, the dragging operation can be 
terminated with the "Escape" key.  Similarly, an "Undo" operation after release of 
the mouse button will undo the drag.  Either operation restores both the pre-drag 
waveform position and the window pan position. 
 
All reference waveforms in the same scale group are dragged together. 
 
If multiple waveforms are selected, they are dragged together. 
 
 
 

4.10.4 Toolbars and Menus 
Functions of Trace are accessed through dialogs (covered later in this manual), 
toolbars, and menus.  
See also chapter "Context Menus". 

Toolbars 
The Trace Main (Entry) Menu and its toolbars are shown in Figure 4-2 below. Items 
found in common MicroSoft Windows® toolbars are shown but are not described 
here.  Annotated items are specific to Trace. 
 

File Menu
Edit Menu

View Menu
Setup Menu

Control Menu
Zoom X and Y with a Box

Zoom In
Zoom Out

Fit All: Overlaid
Measurement Cursor

Cursor Control
Cursor Position

Clear Screen
Fit All: Separated

Annotations

Trace Status
Trace stop Button

Trace start Button
Setup Button

Undo
Redo

Figure 4-3 Trace Main (Entry) Menu and Toolbars 
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Menu: File 
The File menu provides access to the following functions: 
• session management 
• data export 
• print management 
 
The following selections are available from the menu: 
 
New Session… Selection of this item creates a new session. A dialog con-

taining a suggested session name is presented (e.g., “Ses-
sion 1”), but any session name can be applied.  Selection of 
this item automatically creates a new graph window for the 
new session. 
 

Open Session… Selection of this item calls up a sub-menu that allows 
retreival of a session either "From Preserved Sessions 
List" or "From Session File". (See the two descriptions with 
these titles directly below.) 
 
Note  
When a session is retreived, it becomes the active session. 
(I.e., it replaces any currently-displayed session.) 
 
From Preserved Session List… 
Selection of this item opens the Preserved Sessions dialog.  
This dialog presents a list of sessions that are currently 
preserved in the NCU.  Any entry in the list can be selected, 
making it the active session. 
 
From Session File… 
Selection of this item allows a saved session file to be 
opened using the standard MicroSoft Windows® "Open" 
dialog. Selection of a specific file calls up the "Select 
Session Contents to Load" dialog.  Via checkbox, this dialog 
allows the loading of the following: 

• Setup Waveforms, Collection and Triggers 
• Setup Display 
• All Waveform Data 

 
"All Waveform Data" can be further qualified by checking 
"Time from the beginning of the block in seconds". 
 
If signal data is loaded, it is immediately displayed just as if it 
had been freshly recorded. 
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 Note 

Siemens or the OEM can provide pre-configured session 
files for common tasks.  If this is the case, only the session 
file needs to be loaded to obtain the desired setup. 
 
A new session can also be created with this information. 
This would allow the previously active session to reside in its 
window rather than over-writing it. After this waveform data 
is loaded, it is presented in the graph window(s) as the 
active session, just as if the session had not been 
interrupted; however, its data will be lost the next time 
recording is started. 
 

 
Open Session... 
(continued) 

Prior to V06.04, when opening from a Session File, only the 
data associated with a waveform could be suppressed.  
Now, the user can decide via checkbox: 

1. whether or not to load each waveform. 
2. whether to load each waveform as reference or live. 

 
Close Session… Selection of this item closes the active (current) session and 

calls up a dialog that provides the option of either discarding 
or preserving the session and its recorded data. If "Preserve 
Session" is selected, the session will be maintained in the 
NCU even if the Trace application is exited and even if the 
NCU is shut down. The preserved session maintains: 

• the NCU resources 
• the entire setup 
• the recorded signal data (if any). 

 
At some later time, Trace can be reconnected to a 
preserved session. (See "Open Session.. " for information 
about reconnecting to a preserved session.) This 
reconnection allows work with the session to resume. If any 
signal data was recorded by the NCU while the Trace was 
disconnected, the HMI will retrieve that recorded data 
immediately upon reconnection to the session. 
 

 
Save Session… Selection of this item opens the "Save Session" dialog.  

Either "Save Session to File" or "Preserve Session on NCU" 
(or both) must be checked in order to perform a save. The 
"Advanced >>" button can be pressed to allow checkbox 
selection of a only a subset of  the waveforms and 
parameters to be saved. If the Advanced window is not 
used, all setup parameters and the waveforms will be saved 
to the file. 
A path is initially suggested (e.g., "f:\user\").  A filename 
must be specified. Optionally, a new path can precede the 
filename. If this is done, the suggested path disappears. In 
subsequent saves, the new path becomes the suggested 
path. 
At some later time, the sequence "File...Open 
Session...From Session File" can be used to reload the file. 



12.04 4 SinuCom NC: Functions 
 4.10  SinuCom NC Trace 
 
 

© Siemens AG 2004 All Rights Reserved 
SINUMERIK 840D/840Di/810D SYS Commissioning Tool SinuCom NC (INC) - 12.2004 Edition 4-53 

 
Note 
A saved session file that includes waveform data can be 
used later to load reference waveforms, see the Chapter: 
"Sessions and Their Content", Reference Waveform, for 
information on the use of Reference Waveforms.) 
 

Save Image… Selection of this item calls up a standard MicroSoft 
Windows® “Save As” dialog that allows the image of the 
active graph window to be saved to a Windows graphic 
metafile or bmp.  This graphic metafile contains the 
graphical content of the graph window including waveforms, 
axis scales, and annotations, but excludes borders, 
scrollbars, tabs, etc. 
 
Note 
A Windows® metafile is a format that can be resized without 
losing detail. 
 

Import Symbols (New in SinuCom NC Version 06.04.01.00) Selection of this 
item opens the Trace Symbol Import Wizard.  The function 
of this tool is self-explanatory.  This wizard allows the user to 
manually update GUDs and PLC Variables at any time. 
 

Export Wave-
forms… 

Selection of this item opens the "Export Waveforms" dialog, 
The "Advanced >>" button can be pressed to allow 
checkbox selection of a only a subset of  the waveforms to 
be exported. If the Advanced window is not used, all 
waveforms will be saved to the file. 
 
A path is initially suggested (e.g., "f:\user\"). A filename must 
be specified.  Optionally, a new path can precede the 
filename.  If this is done, the suggested path disappears. In 
subsequent saves, the new path becomes the suggested 
path. 
 
Unlike a save Session", an exported waveform file cannot 
be reloaded and re-displayed. 
 
 
 

 Note 
Unlike the XML format of a saved session, an exported 
waveform is a numerical representation of the waveforms to 
be saved in a comma-delimited (.csv) format. This format 
can be easily imported into other applications such as 
Microsoft Excel. 
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Print Preview Selection of this item displays a preview of the impending 

printout in standard MicroSoft Windows® Print Preview 
format. 
 

Print… Selection of this item calls up the Print dialog. 
 
(Note that toggling "Page Setup >>" alternately compresses, 
then expands the lower portion of the screen.). 
 
This print dialog has functionality similar to that of many 
MicroSoft® products, but also has the following two 
capabilities: 

• Print Range - The following two choices are provided: 
- Full Range  

Prints the full recording, on multiple pages if 
required. 

- Current view only  
Prints only the content currently in view. 
 

• Image Size - The following three choices are provided: 
- Actual Size 

The size of the display will be reproduced in print, 
pixel-for-pixel at 100% of its size. One screen of 
data will be produced per page. If the screen is 
larger than the page (X and/or Y), a portion of the 
printout will be cut off. 

- Full Page ("preserve aspect ratio" checked)  
The displayed size ratio of X to Y is preserved. The 
on-screen waveform will be enlarged to either the 
full horizontal or full vertical dimension of the page 
(whichever is reached first). 

- Full Page ("preserve aspect ratio" not checked) 
Both the X and Y dimension of the on-screen 
waveform will be enlarged to the size of the page 
without regard to the displayed size ratio of X to Y. 
Significant distortion is expected unless the aspect 
ratio of the display is close to the aspect ratio of the 
page. 

 
 

• Print Color Scheme - New for V06.04. The following 
three choices are provided: 

- Black and white printer scheme 
- Color printer schemeo  
- Same as display 
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 Note 

Any printout will contain the graphical content of the graph 
window (waveforms, axis scales, and annotations), but 
borders, scrollbars, tabs, etc. will be excluded. The 
displayed scaling of the graphs will be reflected in the 
printout. 
 

Exit Trace Selection of this item exits the Trace facility. 
 

 

Menu: Edit 
Starting with Version 06.04, previously-recorded individual waveforms can be 
added, edited or removed without discarding waveform data that are not involved in 
the changes. To accommodate this, the Edit Menu is now context-sensitive. (I.e., if 
the focus of activity is on a text, this menu accommodates text editing as described 
directly below. If one or more waveforms have focus, this menu supports waveform 
editing as described on the following page.) 
 
The following Edit Menu functions are available for text editing: 
 
Undo Selection of this item will perform an Undo (revert) on the last 

action (if possible). Possible actions for undo include scaling 
and zooming of graph windows, and various changes to 
setup parameters. Undo will not be available for actions that 
involve the actual recording of data or clearing of recorded 
data. 
 

Redo Each redo restores an undo operation until the state prior to 
first undo operation is achieved. 
 
Note 
If an undo-redo operation is performed on a setup parameter 
while the Setup dialog is visible, the dialog is automatically 
switched to the page that contains the changed parameter. 
 

Cut Selection of this item will perform the standard Windows® 
Cut operation. (Replaced by "Cut Waveform" in Version 
06.04 and later, as described below.) 
 

Copy Selection of this item will perform the standard Windows® 
Copy operation. (Replaced by "Copy Waveform" in Version 
06.04 and later, as described below.) 
 

Paste Selection of this item will perform the standard Windows® 
Paste operation. (Replaced by "Paste Waveform as Stan-
dard" and "Paste Waveform as Standard" in Version 06.04 
and later, as described below.) 
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The following Edit Menu functions are available for waveform editing: 
 
Cut Waveform New feature for Version 06.04. Removes the waveform from 

the session and moves it -- and its data -- onto the Win-
dows® clipboard. 
 

Copy Waveform New feature for Version 06.04. Leaves the waveform in the 
session and moves a copy of it -- and its data -- onto the 
Windows® clipboard. 
 

Paste Waveform 
as Standard 

New feature for Version 06.04. Pastes the waveform on the 
Windows® clipboard into the session as a Standard Wave-
form at the end of the waveform order. It can subsequently be 
dragged to another position in the order. 
 
Note 
Standard waveforms, if pasted in the same session, are al-
ways pasted with data. To prevent invalid mixes of data, a 
waveform pasted into a different session will be pasted with-
out data. 
 
Application Hint:  
Multiple copiess of a Standard Waveform can be pasted into 
the same session, and can subsequently be given a different 
bit field specification. Each will be redrawn according to its 
specific bit field. 
 

Paste Waveform 
as Reference 

New feature for Version 06.04. Pastes the waveform on the 
Windows® clipboard into the session as a Reference Wave-
form at the end of the waveform order. It can subsequently be 
dragged to another position in the order. Standard waveforms 
are pasted with data. 
 
Note 
Reference Waveforms are always pasted with data.  If a 
waveform has no data it must be pasted as a Standard 
Waveform. 
 

 
Scale Grouping Note 

Scale Grouping and Multiple Selection are similar (e.g., 
whenever any one waveform is compressed or expanded, all 
associated waveforms are compressed or expanded), but 
they have two major differences: 

1. Scale Grouping is more permanent.  (I.e., waveforms 
in a Scale Group stay together until explicitly split 
apart; waveforms under Multiple Selection stay to-
gether only until another selection is made.) 

2. All waveforms in a Scale Group have the same Y 
axis scaling. 
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 Selection of Scale Grouping opens a submenu with three 

choices, as described below.  A table of scenarios is shown 
for each. For these tables, the following rules apply: 
 

• Group names "A" and "B" designate existing groups. 
• Group name "C" designates a resulting group.  
• "0" indicates an independent (ungrouped) waveform. 
• A BOLD "A", "B" or "C" is a selected waveform. 

 
Note 
If possible, existing group names are preserved. 
 
• Group 

This choice is available if two or more waveforms are se-
lected.  Selection brings up the "Scale Group Properties" 
dialog, in which the group (i.e., all selected waveforms) 
can be given a unique name.  Radio buttons allow the 
waveforms to share the "same Y scale" and optionally the 
"same Y position". 

 
The following table describes grouping behavior: 
 

"Group" Scenarios 
 

Menu 
State 

Initial 
Condi-
tion 

Resulting 
Effect 

One waveform selected grayed AAABB no effect  
Selection spans groups normal AAABB AACC0 
Subset of group selected normal AAA AA0 
Subset of large group selected normal AAAA AACC 
Selection contains ungrouped waveforms normal AA0000 AAAA00 
Entire group selected normal AAAA no effect 
All selected waveforms are ungrouped normal 0000 AAAA 

 
 

Scale Grouping 
(cont.) 

• Ungroup  
This choice is available if the selection contains at least 
one waveform that belongs to a group.  Selection will ei-
ther cause a simple group to "ungroup", or will cause one 
of the other resulting effects as described in the following 
table: 

 
"Ungroup" Scenarios Menu 

State 
Initial 
Condi-
tion 

Resulting 
Effect 

Subset Selected normal AAAABB 00AABB 
Selection spans groups grayed AAABB no effect 
Set minus one element normal AAA 000 
Entire set selected normal AAA 000 
Selection includes unselected normal AAA0 AA00 
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 • Select Entire Group  

This choice is available when a selection contains one or 
more waveforms from a single group, and no others.  It is 
useful for: 
- seeing the full complement of signals for a given 

group. 
- adding a waveform to a group. To do so: 

Right-click on a waveform in the target group  
Click on "Scale Grouping". 
Click on "Select Entire Group". 
<ctrl> click the waveform to be added. 
Click on "Scale Grouping". 
Click on "Group" to add the waveform to the group. 

- performing an operation on an entire group (i.e., 
making sure a group is completely disbanded.) 

 
The following scenarios apply: 
 

 
"Select Entire Group" Scenarios Menu 

State 
Initial 
Condition 

Resulting 
Effect 

One item selected normal AAABB CCCBB 
Selection spans groups grayed AAABB no effect 
Subset of group selected normal AAA AAA 
Subset of large group selected normal AAAA CCCC 
Selection spans unselected items grayed AA00 no effect 

 
 

Menu: View 
The View menu allows waveforms to be enlarged, reduced, repositioned, and  
labeled.  
The following selections are available from the menu: 
 
Show Custom 
View 

Selection of this item returns the scaling and position of all 
waveforms to a previously-established state called the 
"Custom View". If no Custom View has been set, the initial 
view is used. 
 
Note 
Establishing a Scale Grouping overrides a Custom View. 
 

Set Custom View Selection of this item establishes the current view as the Cus-
tom View. 
 

Control Scale > Selection of this item allows manipulation of vertical and time 
scaling through a submenu consisting of the following 
choices: 
 



12.04 4 SinuCom NC: Functions 
 4.10  SinuCom NC Trace 
 
 

© Siemens AG 2004 All Rights Reserved 
SINUMERIK 840D/840Di/810D SYS Commissioning Tool SinuCom NC (INC) - 12.2004 Edition 4-59 

 
Set Vertical Scale Selection of this item invokes a dialog that allows 

numeric min and max vertical scale values to be set 
for the active waveform(s).  (This is especially use-
ful if the amplitudes of two or more waveforms are 
to be visually compared.) 
 

Lock Vertical 
Drag 
 

Prohibits the vertical dragging of the active wave-
form. 

Unlock Vertical 
Drag 

Enables the vertical dragging of the active wave-
form. 
 

Set Time Scale Selection of this item invokes a dialog which allows 
numeric min and max horizontal scale values to be 
set (all waveforms). 
 

Lock All Vertical 
Drag 
 

Prohibits the vertical dragging of all waveforms. 
 

Unlock All Verti-
cal Drag 
 

Enables the vertical dragging of all waveforms. 
 

 
Zoom > Selection of this item allows zooming through a submenu 

consisting of the following choices: 
Zoom X and Y Selection of this item allows an area of the display 

to be magnified in both the X and Y direction. A 
portion of the waveform can be dragged over (i.e., 
left mouse button down, then drag, then left mouse 
button up) in order to zoom to that section. The 
proportion of X-to-Y is dictated by the proportion of 
the zoom box. 
 

Zoom X only Selection of this item is the same as Zoom X and 
Y, but only the X dimension is zoomed. 
 

Zoom Y only Selection of this item is the same as Zoom X and 
Y, but only the Y dimension is zoomed. 
 

 MODAL ZOOM:  
The three zoom capabilities directly above involve 
dragging the mouse.  Their capability can be 
enhanced by MODAL ZOOM. This mode can be 
locked on by double-clicking the zoom button on the 
toolbar. While in modal zoom, the selected area can 
be zoomed repeatedly by dragging, without having 
to click the zoom button again. Modal zoom is 
unlocked by clicking the zoom button again, or by 
clicking anywhere in the graph window without 
dragging. 
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Zoom In Selection of this item causes the display to be 

enlarged by a preset amount. The center of the 
display is maintained. 
 

Zoom Out Selection of this item causes the display to be 
reduced in size by a preset amount. The center of 
the display is maintained. 
 

Fit All: Overlaid Selection of this item fits all waveforms to maximum 
size.  Since all waveforms occupy the full extent of 
the vertical screen, they are "overlaid" with each 
other. 
 

Fit All: Separated Selection of this item divides the screen into 
partitions, one partition for each  visible waveform.  
Each waveform is displayed to its maximum vertical 
size within its partition. 
 

Annotations Repetitive selection of this item toggles the 
annotations on and off for all displayed waveforms. 
 
Note 
Annotations are color-coded waveform names. The 
names are derived from the Waveforms Setup. If a 
Description has been supplied in the Waveforms 
Setup, it is the annotation. Otherwise, the 
Waveform Name is the annotation. 
 
Note 
Both the annotation and its arrow can be dragged to 
a new position on the screen. The arrowhead 
remains stationary when the annotation is dragged; 
the arrow remains parallel to its original orientation 
when the arrow is dragged. 
 
 

Difference Repetitive selection of this item turns the difference 
cursors, and their associated dialog display, on and 
off.  (see a description of "Difference Cursors".) 
 

Measurement Repetitive selection of this item toggles the display 
of the measurement cursors as well as their 
control/display features on the measurement 
toolbar, see the Chapter: Dialogs, Measurement 
Cursor, for information on the use of the 
Measurement Cursor.) 
 

Show All Wave-
forms 

Selection of this item causes all waveforms to be 
visible. 
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Hide All Wave-
forms 

Selection of this item causes all waveforms to be 
hidden. 
 

Hide Dropouts /  
Show Droputs 

Selection of this items turns the visible state of all 
dropout indicators on and off. (A dropout indicator is 
a pair of vertical lines that shows when a dropout 
begins and ends. 
 
Note 
A dropout indicator is a pair of vertical lines that 
shows where a dropout begins and ends.  (A drop-
out is a portion of a waveform for which the signal 
data is not available.) 
 
Note 
Dropouts can occur for a number of reasons, but 
the most common reason is that Trace could not 
process the signal data as fast as it was being ac-
cumulated at the signal source. 

 
Toolbars This menu item allows the display of individual 

toolbars to be turned on and off (e.g. the Control 
toolbar). 
 

 

Menu: Insert 
The Insert menu is new in V06.04. The following selections are available from the 
menu: 
 
Add Waveform... Directs focus to the "Add Waveform" dialog. 

 
Waveforms Allows the introduction of an additional waveform 

into the currect session either from a file or from 
another session. 

 

Menu: Setup 
The Setup menu provides access to the Setup dialog. Each menu item allows 
quick access to a particular page of the Setup dialog. Alternately, the Setup toolbar 
button calls up the Setup dialog to the page last used. The following selections are 
available from the menu: 
 
Waveforms… This menu item opens the Setup dialog with the Waveforms 

page selected, 
(see the Chapter: Dialogs, Dialog: Setup Waveforms). 
 

Collection… This menu item opens the Setup dialog with the Collections 
page selected, 
(see the Chapter: Dialogs, Dialog: Setup Collection). 
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Trigger… This menu item opens the Setup dialog with the Trigger page 
selected, 
(see the Chapter: Dialogs, Dialog: Setup Trigger).  
 

Sample Rates This menu item opens the Setup dialog with the Sample 
Rates page selected, 
(see the Chapter: Dialogs, Dialog: Setup Trigger). 
 

Display… This menu item opens the Setup dialog with the Display page 
selected, 
(see the Chapter: Dialogs, Dialog: Setup Display).  
 

 

Menu: Control 
The Control menu allows the recording process to be started and stopped, and the 
screen to be cleared. The trace status window indicates one of the following states 
• Stopped 
• Waiting for trigger 
• Recording 
 
The following selections are available from the menu: 
 
Start 

 

Selection of this item makes Trace ‘active’, and initiates 
monitoring for the trigger condition. If no trigger condition has 
been defined, recording begins immediately upon Start. If the 
setup parameter Auto-start at power-on is set True, 
monitoring for the trigger condition starts automatically at 
power-on. 
 

Stop 

 

Selection of this item makes Trace ‘inactive’, and stops 
recording or stops waiting for the trigger condition.  This 
action is not needed if recording stops automatically because 
the recording duration is satisfied. 
 

Clear 

 

Selection of this item clears the current graph window of any 
waveforms. 
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Menu: Window 
The Window menu provides features comparable to its MicroSoft Windows® 
counterpart. In addition to windows arrangement and control, it allows multiple 
graph windows to be created and manipulated. All graph windows draw from the 
same acquired data, but each window can be manipulated independently. 
 
 
The following selections are available from the menu: 
 
New Window Selection of this item creates a new graph window. The new 

window becomes the new active session. Waveforms in the 
new window are a copy of the old window. This allows 
manipulation in the new active window without change in the 
old.  When more than one window is present, tabs appear 
below the windows to allow for quick selection with the 
mouse. 
 
Note 
Multiple windows allow convenient waveform comparison. 
They also can relieve clutter by grouping sets of relevant 
waveforms and eliminating irrelevant ones. 
 

Cascade Selection of this item arranges all windows in an overlapped 
fashion. 
 

Tile Horizontally Selection of this item arranges all windows in non-overlapped 
horizontal tiles. 
 

Tile Vertically Selection of this item arranges all windows in non-overlapped 
vertical tiles. 
 

Graph Window n This menu item selects a particular graph window for viewing.  
This menu item is repeated for each available graph window. 
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4.10.5 Context Menus 
A context menu is a pop-up menu that appears when the right mouse button is 
clicked over a specific area or type of item.  It appears at the click point and is 
context-specific (i.e., the items in the menu will vary depending on the area 
clicked.)  Context menu items are often the same items found on normal menus, 
but they provide an alternate way to quickly access functions that apply to the area 
that was clicked. 
 

Context Menu: Graph Window 
This context menu appears when any empty space in the graph window is right-
clicked (i.e., where there is no waveform). 
 
Add Waveform This menu item opens the Add Waveform dialog (identical to 

the "Dialog: Setup Display") 
 

Setup This menu item cascades to a sub-menu that is identical to 
that of the Setup menu 
 

New Session This menu item is identical to the one of the same name 
found on the File menu 
 

Cut Waveform This menu item is identical to the one of the same name 
found on the "Menu: Edit".  
  

Copy Waveform This menu item is identical to the one of the same name 
found on the "Menu: Edit". 
 

Paste Waveform 
as Standard 

This menu item is identical to the one of the same name 
found on the "Menu: Edit". 
 

Paste Waveform 
as Reference 

This menu item is identical to the one of the same name 
found on the "Menu: Edit". 
 

Edit Graph Win-
dow Colors 

This menu item opens the Graph Window Colors dialog 
(identical to the dialog accessed by the "Colors" button in the 
Setup Display Dialog. 
 

Show All Wave-
forms 

This menu item is identical to the one of the same name 
found on the "Menu: View". 
 

Hide All Wave-
forms 

This menu item is identical to the one of the same name 
found on the "Menu: View". 
 

Hide Dropouts This menu item is identical to the one of the same name 
found on the "Menu: View". 
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Show Custom 
View 

This menu item is identical to the one of the same name 
found on the "Menu: View". 
 

Set Custom View This menu item is identical to the one of the same name 
found on the "Menu: View".  
 

Control All 
Scales 

This menu item cascades to a sub-menu with the following 
selections: 
     Set Time Scale 
     Lock All Vertical Drag 
     Unlock All Vertical Drag 
     Fit Time to Window 
Descriptions for these choices can be found under "Menu: 
View". 
 

Zoom This menu item cascades to a sub-menu with the items on 
the View Menu used for zooming and scaling. 
 

Annotations This menu item is identical to the one of the same name 
found on the "Menu: View". 
 

 

Context Menu: Waveform 
This context menu appears when a waveform or waveform tab is right-clicked. 
 
Add Waveform This menu item opens the Add Waveform dialog (identical to 

the "Dialog: Setup Waveforms"). 
 

Edit Waveform This menu item opens the Edit Waveform dialog (identical to 
the dialog accessed by the "Edit" button in the "Dialog: Setup 
Waveforms"). 
 

Remove Wave-
form 

This menu removes the selected waveform(s) (identical to the 
dialog accessed by the "Remove" button in the "Dialog: 
Setup Waveforms"). 
 

Cut Waveform This menu item is identical to the one of the same name 
found on the "Menu: Edit". 
 

Copy Waveform This menu item is identical to the one of the same name 
found on the "Menu: Edit". 
 

Paste Waveform 
as Standard 

This menu item is identical to the one of the same name 
found on the "Menu: Edit". 
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Paste Waveform 
as Reference 

This menu item is identical to the one of the same name 
found on the "Menu: Edit". 
 

Edit Style This menu item opens the Waveform Style dialog (identical to 
the dialog accessed by the "Edit" button in the "Dialog: Setup 
Waveforms"). 
 

Edit Description This menu item moves the cursor to the waveform's tab, al-
lowing immediate editing of the waveform description. 
 

Show Waveform This menu item causes the waveform to be visible (identical 
to checking the "Show" checkbox shown in Figure 4-2). 
 

Hide Waveform This menu item causes the waveform to be hidden (identical 
to unchecking the "Show" checkbox shown in Figure 4-2 
(tiled horizontally)). 
 

Control Vertical 
Scale > 
(formerly "Re-
size Waveform) 

Selection of this item allows manipulation of vertical scaling 
through a submenu consisting of the following choices: 

 
Set Vertical 
Scale 

This menu item is identical to the one of the same 
name found on the "Menu: Edit". 
 

Lock Vertical 
Drag 

This menu item is identical to the one of the same 
name found on the "Menu: Edit". 
 

Unlock Vertical 
Drag 

This menu item is identical to the one of the same 
name found on the "Menu: Edit". 
 

Fit Height to 
Window 

This menu item performs a function identical to the 
"Fit Height to Window" icon found in Figure 4-1. 
 

 
Scale Grouping This menu item is identical to the one of the same name 

found on the "Menu: Edit". 
 

Waveform Tabs This menu item cascades to a sub-menu with the following 
selections: 
     Show Text 
     Show Numbers 
     Show Both 
These choices are duplicates of the ones found in the "Dia-
log: Setup Display". 
 

Annotations This menu item is identical to the one of the same name 
found on the "Menu: View". 
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Context Menu: Setup Waveform Dialog 
This context menu appears when the Setup Waveform Dialog is right-clicked. 
 
Add Waveform  This menu item opens the Add Waveform dialog (identical to 

the "Dialog: Setup Waveforms"). 
 

Edit Waveform This menu item cascades to a sub-menu with the following 
selections: 
 Edit Style (identical to "Edit Style") 
 Edit Description (identical to "Edit Description"). 
 Edit Signal Specification (identical to "Edit Wave
 form"). 
 Edit Bitmask (opens the Bit Editor Dialog [identical to 
 the dialog accessed by the "Bit" button in the Edit 
 Waveform Dialog. See also "Bit Mask"). 
 

Remove Wave-
form 

This menu removes the selected waveform (identical to the 
dialog accessed by the "Remove" button in the "Dialog: 
Setup Display"). 
 

Cut Waveform This menu item is identical to the one of the same name 
found on the "Menu: Edit". 
 

Copy Waveform This menu item is identical to the one of the same name 
found on the "Menu: Edit". 
 

Paste Waveform 
as Standard 

This menu item is identical to the one of the same name 
found on the "Menu: Edit". 
 

Paste Waveform 
as Reference 

This menu item is identical to the one of the same name 
found on the "Menu: Edit". 
 

 
 

Event Data Display 
More than one data item can be recorded on the same event. If this occurs, a 
single marker (point) will be visible, but others may be hidden directly below it. To 
see all of the data represented by the single marker, the mouse pointer can be 
moved (hovered) over the plot marker. After a brief delay, a window will temporarily 
appear near the marker (until the mouse is moved again). This window displays the 
name of the event, followed by the name or description and value of each data 
item recorded on that event. 
 
If the mouse is clicked on the event marker, this window remains displayed on the 
screen if the mouse is moved or clicked elsewhere. The Close button dismisses 
this window. 
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4.10.6 Dialogs 
Most Trace dialogs pertain to the presentation of waveforms. They are called Setup 
Dialogs (described below). 
 
Dialogs are interactive displays. They are called dialogs because have three major 
functions. Each one: 
1. displays a category of information. 
2. allows the modification of this information. 
3. feeds back the effects of the updated information. 
 

Setup Dialogs 
As stated above, Setup Dialogs control the presentation of the waveforms. They 
are used to identify what data to record and when to record it. When either the 
Setup Menu or Setup Button is clicked (as shown in Figure 4-3), the Setup Dialogs 
are presented as the following group of tabbed pages: 
• Waveforms 
• Collection 
• Trigger 
• Sample Rates 
• Display 
 
 

Dialog: Setup Waveforms  
This dialog facilitates the preparation for waveform recording, including the 
selection of signals to be recorded. It presents a table of all signals that are 
currently selected. As much as possible, only choices that result in a valid 
configuration are presented. The designed configuration is cross-checked and 
validated against system resources. This may result in error messages that will 
describe which part of the setup is invalid. 
 

 Note 

Settings that affect recording can be changed only when recording is not in 
progress. 
 

 

 Note 

In addition to the functionality described below, the Cut/Copy/Paste functions will 
also operate in this dialog.  If a field other than the "#" (number) field is selected, 
the Cut/Copy/Paste functions operate only on the value in that field.  If the "#" 
(number) field is selected, the Cut/Copy/Paste functions operate on the entire 
waveform record.  This is an effective way, for example, to duplicate one or more 
waveform entries, or to copy one or more waveforms to another session. 
 

 
See also "Context Menus: Setup Waveform Dialog" 
 



12.04 4 SinuCom NC: Functions 
 4.10  SinuCom NC Trace 
 
 

© Siemens AG 2004 All Rights Reserved 
SINUMERIK 840D/840Di/810D SYS Commissioning Tool SinuCom NC (INC) - 12.2004 Edition 4-69 

In the table below, each entry is read-write unless otherwise specified, and has the  
following attributes: 
 
# (number) (Read-only) This field contains the waveform’s reference 

number. This number is automatically assigned, and is used 
elsewhere to reference the signal or its waveform. When a 
signal is removed from the list, the subsequent signals are 
renumbered to remove the gap. 
 
Note 
The number field can be dragged up or down to a new table 
row.  This action moves all the signal attributes connected to 
that number field to the new row, and then renumbers the 
signals. 
 

Style Double-clicking on an entry in the Style field displays the 
"Waveform Style" window. This window facilitates the 
configuration of the following attributes, each of which are 
further described below: 

• Line Style 
• Line Width 
• Marker Style 
• Waveform Color 
• Axis Display 
• Plot Y Option 

The selected attributes are previewed on the displayed 
waveform prior to acceptance. 
 
 

Style (continued) Dropping down the Line Style menu allows the following 
characteristics for lines connecting the data points: 

• Line None 
• Line Solid 
• Line Dash 
• Line Dash Dot 
• Line Dash Dot Dot 
• Line Dot 
• Line StepXY 
• Line Step YX 

 
Note 
"Line Solid" is the default for cyclic events.  "Line None" is the 
default for non-cyclic events. 
 
Line Widths between 1 and 5 inclusive can be selected 
using the up-down arrows shown. 
 
Markers can optionally be plotted on the waveform at the 
data points.  Several Marker Styles are available in the drop-
down menu (asterisk, diamond, cross, etc.)  See the actual 
menu within Trace for current content. 
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 Clicking the "Select" button next to Waveform Color displays 

a standard Color Selection dialog. The desired waveform 
color can be defined by simple selection, or custom colors 
can be defined using the associated button. 
 
Axis numbering and labels can be positioned to the Left, 
Right, Both, or None using the Axis Display drop-down 
menu. 
 
The Plot Y Option is active only for non-cyclic events 
(primarily because it usually does not make sense to use the 
value of a non-cyclic event for its own Y coordinate). This 
option has three possible selections: 
• Source Y:/<description> - The non-cyclic occurrences 

will superimpose onto the waveform identified by 
<description>. I.e., the value of <description> is used as 
the Y coordinate.) 

• Snap Y – The non-cyclic occurrences will "snap" (i.e., 
superimpose themselves) onto the waveform that has 
focus. 

• Same Y for Each – The non-cyclic occurrences will plot 
at Y=0.00 (i.e., in a straight horizontal line). 

 
Event This item specifies the occurrence at which the signal data is 

to be recorded.  The event for each signal is selected in the 
Add Signal dialog, see "Dialog: Add Waveform" for details. 
 

Event Channel This optional field identifies the Sinumerik channel in which a 
specific event is to occur. The field is blank for events that are 
not channel-specific. (See the appropriate Sinumerik 
documentation for the definition of the term "channel".) 
 

Description This comment field is available for general description.  It is 
used to annotate the waveform. It can be overwritten as 
desired.  When a signal is first selected, its signal description 
appears in this field (if it has been defined by the machine 
builder). If there is no signal description, the signal name 
appears, and is appended with a channel/axis/drive index (if it 
exists). 
 

Bit Mask If the signal is an integer, this field can be used to specify an 
optional Bit Mask. The signal value is AND’ed with this Bit 
Mask before it is displayed.  After masking, all the selected 
bits are squeezed to the right so that the bit/bits appear as if 
they start at bit 0 (e.g. if all but bit 7 were masked, the 
resulting integer would have a value of either 0 or 1, not 0 or 
128; if all but bits 7 and 0 were masked, the resulting integer 
would have a value of either 0, 1, 2 or 3 [not 0, 1, 128 or 
129). 
 

 
Units (Read-only) This field describes the signal's units (e.g. 

mm/min). 
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Decimal Places This setting determines the number of digits to the right of the 
decimal point that will be displayed on the axis labels. 
 
Note 
This selection also affects the number of decimal places 
shown in the hover display. 
 

Scale Grouping If there is a text string in this field, it synchronizes the de-
scribed waveform with all other waveforms having the same 
text string.  This collection of waveforms is called a “Scale 
Group”. If this field is empty there is no synchronization of 
scaling. 

 
Example: 
Assume this text string is “AxisPos” for waveforms 2 and 3. 
Whenever the scaling of either is changed, the scaling for the 
other is changed as well.  If either is stretched or shrunk, the 
other stretches or shrinks to match. 
 

Signal Specifica-
tion 

This field contains the identification of the signal in proprietary 
Sinumerik format. 
 

Signal ID This field specifies the Machine Data number of the signal if 
one exists.  (See the appropriate Sinumerik documentation 
for a definition of "Machine Data number".) 
 

 
In addition to the fields described above, this dialog also includes the following 
buttons: 
 
Add This button calls up the Add Waveform dialog. This dialog 

allows the addition of an item to the list of waveforms to be 
recorded. (See "Dialog: Add Waveform" for more 
information.) 
 

Edit This button allows editing of the selected item. It brings up 
the same dialog as the Add button. 

Remove This button removes the selected item from the list. 
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Dialog: Add Waveform 
The Add Waveform dialog appears when the Add button on the Waveforms page 
of the Setup dialog is pressed. See Figure4-4) In this dialog, the event, name and 
other characteristics of a signal are selected. The Add button can then be clicked to 
add that signal to the list of items to be recorded. 
 
There are five tabs across the top of the dialog. They allow the various methods of 
selection described in the next few pages. The following item is common to the 
screens associated with the first four tabs: 
 
Event This setting specifies when to record, on a per-point basis. 

(See the Chapter: Overview, How Trace is Used, List of 
Events.) 
 

Description The content of this box defaults to the "Name" of the selected 
waveform in the list of names below it.  Typically, the user will 
change this to a descriptive phrase for the waveform.  When 
"Add" is clicked, the description follows the entry to the 
"Setup: Waveforms" dialog. 
 

 
If a new waveform is added, the makeup of the session is changed. To ensure that 
settings always match data, and unless there are no waveforms displayed, the 
"Keep Data" dialog appears before access to the Add Waveforms dialog is allowed. 
This provides the opportunity to either save the session as it currently exists, or 
discard it. 
 
After the choice is made, new waveforms can be added as described in the 
following sections. 
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Add Waveform by Name 
The "By Name" dialog (shown in Figure 4-4) is the first of five dialogs that is 
accessible under Add Signal, and thus appears upon entry into this area. As its 
name states, it is used to select the signal "by name". The list on the right side of 
the dialog displays a list of names, ID’s, and descriptions. (Descriptions are 
typically supplied by the machine builder.) The list can be sorted by any column by 
clicking on its heading. The list is filtered based on the password currently in effect. 
 

 
Figure 4-4 Add Waveform By Name 
 

 Note 

If the PLC or Global User Data (GUD) categories display no entries, run the 
TSIW, as described on chapter "Trace Symbol Import Wizard (TSIW)". 
 

 
 
Show Only This box provides a means to filter the list of names.  Selec-

tions in this area cause the list to show either "All Variables", 
or to show only one category of variables (i.e., Axis, Channel, 
NCK, etc.; A:, B:, C:, etc.).   Selecting one category shortens 
the list to make it easier to find a specific name.  The content 
of each category is described on screen, in the dialog. 
 

Containing This box acts as an additional filter, showing only variable 
names or IDs that contain the entered text.  Even if only part 
of a name is entered, the list will be reduced to aid in finding 
a specific name. 
 
Note 
An orange "X" will appear in the containing field to indicate 
that the list is being filtered. 
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Bit Mask If the variable is an integer, this field can be used to specify 

an optional Bit Mask. The signal value is AND’ed with this Bit 
Mask before it is displayed. After masking, all the selected 
bits are squeezed to the right so that the bit/bits appear to 
start at bit 0 (e.g. if all but bit 7 were masked, the resulting 
integer would have a value of either 0 or 1, not 0 or 128; if all 
but bits 7 and 0 were masked, the resulting integer would 
have a value of either 0, 1, 2 or 3 [not 0, 1, 128 or 129). 
 

"Add To" New in V06.04, this drop-down list allows the user to specify 
the window in which any new waveform appears. 
 

 
Based on the name selected, other "qualifiers" may be needed to identify it as a 
unique entity. Fields designed to assist in this identification will appear in the upper 
right of the dialog as needed (in this example shown as "Tool Area", "Point Tool 
Off", and "TN". For instance, in Figure 4-4, above, the "Tool Area" field has a drop-
down menu (not shown) that offers a list of tool areas from which to select. 
 
Often the selection from drop-down menu is self-explanatory, such as the case of 
the "Tool Area" field described above. Occasionally, however, the selection of a 
name will cause a field labeled "See DocOnCD" to appear. In these cases, the 
information required is very specific to the variable (e.g., the selection of an array 
index or an override). The detailed information needed to correctly select the entry 
can be found in DocOnCD under the name being configured. 
 
 

Add Waveform by Address 
The "By Address" tab (shown Figure 4-4) represents the second of five dialogs that 
is accessible under Add Signal.  Rather than selecting by name, the signal can be 
identified by a PLC address or a BTSS path specification. 
 
 

 Note 

Access to this page is password-restricted. 
 

 
 
There are two tabs on the "By Address" screen. "PLC Address" is the first tab, and 
is thus the default dialog when the "By Address" option is selected. Entries in the 
following fields are required to identify a specific address: 
 
Memory Range One of the following memory areas must be selected: 

1. Input area 
2. Output area 
3. Bit memory area 
4. Data block 
 

Offset The specified offset is added to the starting address of the 
Memory Range.The resultant sum is the address of the 
selected variable. 
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Data Type One of the following data types must be selected: 

1. Character 
2. Byte 
3. Boolean 
4. Integer 
5. Word 
6. Double Integer 
7. Double Word 
8. Real 
 
The memory location which is identified by the Memory 
Range and Offset will be interpreted as the identified Data 
Type. 
 

 
Waveforms can also be identified by "BTSS Address". BTSS is an addressing 
scheme that is proprietary to Sinumerik.  A high level of proficiency is required to 
use this method to identify signals. Information on the structure of BTSS addresses 
can be found elsewhere in Sinumerik documentation. 
 

Add Waveform by Function 
Add Signal by Function will be implemented in a future release. It is not available at 
this time. 
 

Add Waveform – "Event Only" 
Signals can be added by "Event-Only". This is the special case where no data is 
recorded. (I.e., only the occurrence of the event is recorded.) Identification of the 
Event is all that is required to effect this type of recording. The choices in the drop-
down menu are the same as the items in the Chapter: Overview: How Trace is 
Used, List of Events". 
 

Add Waveform – Favorites 
When this tab is clicked, a list of the most recently used Event / Data combinations 
will be displayed for selection. A maximum of 20 signals are retained in the list. 
Unless marked as a "favorite", the oldest signal is dropped when a new signal is 
added. 
 
The following buttons are provided: 
Add to Favorites 
 

This button marks the highlighted signal with "***" in the  
"Favorite" column. The entry will then be kept in the list even 
if it has not been used recently. 
 

Remove 
 

This button removes the highlighted entry from the Recently 
Used List. 
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Add Waveform – From File 
This tab, new for V06.04, displays an "Insert from File" dialog that allows selection 
of specific waveforms from a session file.  These new waveforms can be brought in 
either as live waveforms, or as reference waveforms if they have data associated 
with them. 
 

Dialog: Setup Collection  

 
Figure 4-5 Dialog: Setup Collection 
 
The settings described in this section specify when collection (recording) is to start 
and when it is to stop. As these settings are changed, a graphic image (i.e., the bar 
across the window near the bottom) dynamically changes to illustrate how these 
settings affect the collection process. 
 

 Note 

Depending on the capabilities of the version of Trace that is installed (driven by 
the version of NCK software), some of these choices may not be available and 
therefore will be hidden or disabled. 
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"When to Start" Collection (left side of screen, Figure 4-5) 
There are two choices in the drop-down menu for this feature, as shown directly 
below: 
 
Immediately 
 

This choice specifies that recording should start immediately 
when the start button is pressed (i.e. don’t wait for any start 
trigger condition). 
 

Start Trigger 
 

This choice specifies that recording should start only if the 
start trigger condition has been satisfied.  If so, the next 
setting specifies exactly when the recording starts, relative to 
the trigger: 
 

• At Trigger – start recording exactly at the time of the 
trigger 

 
• Before Trigger – start recording at the specified time 

before the trigger occurs (pre-trigger) 
 
• After Trigger – start recording at the specified time after 

the trigger occurs (post-trigger) 
 
Specifics of the trigger condition are defined on the Setup 
Trigger page. 
 

 
The following Funktions will be implemented in a future release. 
Additionally, there are three checkboxes available to further define when collection 
should start: 
 
Automatic 
restart 
 

A check in this box will cause the trigger to re-arm each time 
the recording stops. This immediately places Trace back into 
the 'active' state, waiting for another trigger. After each 
trigger, the new waveforms are displayed as the new data is 
collected. 
 
Note 
This selection is not valid for Endless Recording  
(see Figure 4-7). 
 

Auto-Start at 
power on 
 

A check in this box activates Trace at power on. In addition to 
automatically being ready for a defined trigger, this feature 
also allows for the recording of data that occurs during the 
power-on sequence). 
 
Note 
Triggers function the same during the power-on sequence as 
they do at any other time. 
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Append data 
 

A check in this box causes new data (evoked by a new 
occurrence of the trigger) to be appended to old data.  If the 
box is not checked, the new data replaces the old data. 
 
Note 
If appended, the data will not represent a continuous 
timeframe. There will be time gaps within it. 
 
Note  
This setting is useful in combination with the trigger setting 
“Automatic restart“. 
 
Note  
This selection is not valid for Endless recording  
(see Figure 4-7). 
 

Keep data on 
NCU until 
stopped 

A check in this box will cause Trace to keep recorded data on 
the NCU until recording is stopped (i.e., to defer offloading 
the data to the Trace HMI). If this box is not checked, Trace 
will offload recorded data from the NCU to the Trace HMI as 
soon as possible, even while recording is in progress. 
 
Note 
If this box is checked, the "Data Limit" value (see next page) 
applies to storage on the NCU. If this box is not checked, the 
"Data Limit" value applies to storage on the Trace HMI. 
 

 

"When to Stop" Collection (right side of screen, 4-5) 
The upper drop-down menu has three choices. This area of the screen changes 
based on the choice, so a figure is provided for each, as shown directly below: 
 

Stop Trigger 
 

 
Figure 4-6 Stop Trigger 
 

This choice specifies that termination of the recording is 
controlled by a predetermined Stop Trigger. The second 
drop-down menu can place a time qualifier on the Stop 
Trigger, as follows: 

• At Trigger – Recording stops exactly at the 
occurrence of the Stop Trigger. 

• After Trigger – Recording stops at the specified time 
after the trigger occurs (post-trigger). 
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Time Limit 
 

 
Figure 4-7 Time Limit 
 

This choice specifies that the recording will occur only for the 
time period specified in the "Stop After" field.  
 
A Data Limit can also be set. If the Data Limit is reached, one 
of the two choices from the "At Data Limit" drop-down menu  
prevails, as follows: 

• Discard Oldest Data 
• Stop Collecting 

 

Endless 
 

 
Figure 4-8 Endless 

This choice specifies that the recording continues until the 
recording is manually stopped. A circular buffer is used to 
store the recorded data, so only the most recent data will be 
available for display. (i.e., the oldest data may be lost.). The 
size of the circular buffer is specified in the "Data Limit" field. 
 
A check in the "Keep most recent" checkbox will cause only 
the specified number of seconds of data to be retained. 
Additionally, the data is limited by the Data Limit amount. No 
check in this box will cause data collection to be limited only 
by the Data Limit amount. 
  

 

Dialog: Setup Trigger  
The settings described in this section define the characteristics of the trigger. If the 
use of triggers is specified on the Setup Collection page, there is either a stop 
trigger, a start trigger or both. These triggers apply to all recording within a given 
session. If no triggers are specified on the Setup Collection page, this Setup 
Trigger page is not used (and is not available). 
 
Start Trigger/ 
Stop Trigger 

This pair of buttons can optionally be present. Two conditions 
are possible: 

• Buttons present - Both a start and a stop trigger 
have been specified.  Selection is mutually exclusive. 
On-screen data switches with the selection. 

• Buttons not present - Either a start or a stop trigger 
has been specified. The data applies to the specified 
trigger. 

Note  
As described above, if there are no triggers, the window in 
(see Figure 4-8) above will not appear. 
 

Trigger 
Waveform 

This setting specifies which signal will be used in the makeup 
of the trigger. The following selections are available: 

• No trigger (i.e., field is left blank). 
• Names of waveforms already defined for collection 

(can be accessed via drop-down menu). 
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Trigger Mode This setting specifies the type of test to be performed on the 

trigger waveform. The following selections are available: 
• Rising edge1 – Recording begins or ends when the 

trigger transitions from lower to higher than the trigger 
level. 

• Falling edge1 – Recording begins or ends when the 
trigger transitions from higher to lower than the trigger 
level. 

• Equals – Recording begins when the trigger is equal 
to the trigger level. 

• Not equal to –Recording begins when the trigger is 
not equal to the trigger level. 

• Greater than or equal – Recording begins when the 
trigger is greater than or equal to the trigger level. 

• Less than or equal – Recording begins when the 
trigger is less than or equal to the trigger level. 

• Value changed1 – Recording begins when the trigger 
changes from what it was at the start of recording. 

 
1 These functions will not appear if the installed NCK version 
does not support them. 
 

Trigger Level This setting specifies the trigger waveform threshold that is 
tested by the Trigger Mode. 
 

 

Dialog: Setup Sample Rates 
Some events are cyclic in nature. (see the Chapter: Overview, How Trace is Used, 
List of Events). They appear in the "Setup Sample Rates" dialog.  This dialog al-
lows a multiplier, or "skip count", to be applied to each of these events to reduce 
their associated sampling rates (or, stated another way, increase their intervals). 
The multipliers must be positive whole numbers. 
 

 Note 

Sometimes after a session file is loaded, the sample rate parameters specified in 
the newly-loaded session file cannot be realized with the current Basic Interval of 
the NCU.  In this case, a text message in red letters will appear on the "Setup 
Sample Rates" dialog to indicate that the sample rates have been adjusted to 
numbers that can be realized.  In this condition, a button on the dialog can be 
selected to acknowledge this adjustment and dismiss the warning message. 
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Dialog: Setup Display  
This dialog allows the visual characteristics of the waveform display to be 
configured. 
 

 Note 

The effects of the changes are immediately reflected in the waveform display. 
 

 

 Note 

Unlike other tabbed pages of the Setup dialog, these settings (except "Colors...") 
apply to each graph window independent of other graph windows. 
 

 
Rename/Select 
Graph 
 

This setting selects the graph window to which the display 
settings are applied. The Graph Window name can also be 
modified from this dialog. 
 
Note 
This field is not visible if only one Graph Window is present. 
 

Waveform Tabs 
 

This setting specifies the markings on the waveform tabs.  
The choices are: 
1. Show Text - The complete text description / name of the 

waveform. 
1. Show Numbers - The number of the waveform. 
2. Show Both. 
 
Note 
It may be preferable to show the text name if there are only a 
few signals; conversely, to reduce clutter, it may be 
preferable to show only the number if there are many signals.
 

 
Colors… 
 

This button calls up "Graph Window Colors" dialog. Through 
its use, the colors of the following components of the graph 
window may be changed: 

• Background color. 
• Grid lines color (major and minor). 
• Axis labels color. 

 
To change the color of one of these items, click the "Select" 
button adjacent to it. A standard color selection dialog will 
appear. The desired waveform color can be defined by 
simple selection, or custom colors can be defined using the 
associated button. 
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Scaling (both X 
and Y Axes) 
 

These settings determine the type of scaling for the graphs' 
axes. The choices are: 

• Linear scaling 
• Logarithmic scaling 

 
Note  
Logarithmic scaling is not allowed for the X axis if Graph 
Style is “Y vs. Time”. 
 

Grid Lines (both 
X and Y Axes) 

A check in one or both of these boxes determines if either the 
horizontal grid lines, vertical grid lines, or both, are visible. 
 

 

Measurement Cursor 
Accurate values of sampled data points can be determined through the use of the 
Measurement Cursor. This cursor can be added or removed from the waveform 
display either through the View Menu (as described Chapter: Toolbars and Menus, 
Menu: View) or through its icon (Figure 4-3). The numeric readout on the toolbar 
reflects the X and Y positions of the selected sample point on the active waveform. 
The cursor can be dragged to a desired sample point, or can be incrementally 
moved from point to point using the arrows on the Measurement Cursor toolbar. 
 

Difference Cursors 
The difference cursors are a pair of cursors that provides a function similar to the 
Measurement Cursor.  But instead of just one position, these are two cursors that 
show two X and two Y positions, as well as the difference between them.  The po-
sition and difference information is displayed in a dialog that is visible whenever the 
Difference Cursors are turned on. 
 
The cursors can be attached to the same waveform or to different waveforms.  The 
waveform association is made within the dialog by first expanding the dialog with 

the  button and then choosing the waveforms from a dropdown list of waveform 
descriptions. 
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4.10.7 Trace Symbol Import Wizard (TSIW) 

 Note 

GUD and OEM PLC symbols are not available to SinuCom NC Trace until the 
TSIW is run.  SinuCom NC Trace adds selected symbols to the database when 
this wizard finishes.  These symbols are also automatically imported on any sub-
sequent installations of SinuCom NC Trace.  As with any subsequent use of the 
TSIW, this update of symbols can take several minutes. 
 

 
Previous releases of SinuCom NC Trace use a static symbols database (i.e., the 
set of variables that can be plotted). This database simply shipped with the system.   
The TSIW, new with V06.04, offers the ability to update this database at any time 
with a variety of symbol types from the machine environment. This data does not 
have to be coincident with an NCK release, but instead might be part of a PLC re-
lease, or be provided by an OEM installation. Such data includes: 
 
Global User Data (GUD): Symbols specified by multiple providers.  Categories in-
clude: 
• System GUDs – Provided by Siemens. 
• OEM GUDs – Provided by a machine manufacturer. 
• User GUDs – Provided for a part program or specific factory floor application. 
• GUD 4 – 9: Available for special purposes. 
 
PLC VDI Symbols – Names of PLC data created by Siemens and shipped with a 
version of the PLC software.  
 

 Note 

A set of PLC VDI symbols ships with SinuCom NC. A special procedure  
must be performed to update these. (See "How to Make Symbols Available for 
Import" " 
 

 
PLC OEM Symbols – Names of PLC data created for a particular machine appli-
cation by a machine manufacturer. 
 

 Note 

Local User Data (LUD) and Program User Data (PUD)are temporary variables 
created by a part program or a subprogram. The NCK creates this data at the 
request of a part program and removes it when the program terminates. The 
TSIW does not address this type of data in V06.04. 
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How To Make Symbols Available for Import 
Before using the TSIW, certain types of symbols must be staged for import, as 
described below: 
 
GUDs: Nothing needs to be done for these symbols.  The machine environment 
either has them available or it doesn’t. 
 
 
PLC Symbols (OEM or VDI): This 2-step procedure must be performed only once, 
prior to first use of SIMATIC Manager.  It installs the SIMATIC Manager toolbox.  If 
this procedure has already been performed, please skip to the next appropriate 
section. 
 

 Note 

If you have downloaded the toolbox installer, start the downloaded file.  (It may be 
called 07010100.exe).  This creates a folder that contains the setup.exe program.
 

1. Using the PG/PC, call up PLC Toolbox Setup. 
 
2. Under "Programs to be installed": 

• click "PLC Basic Program for <control> Vv.w", and 
• click "SINUMERIK Add-on for STEP 7 Vx.y". 

 
3. Click "Next", then continue with the procedure directly below. 
 
Exporting the PLC Input/Output/Bit Memory Symbols from SIMATIC: 
 
1. From the Windows® desktop, launch the SIMATIC Manager by selecting 

"Start", "Programs", "SIMATIC", then "SIMATIC Manager" 
 

2. Press "Cancel" to dismiss the "New Project Wizard". 
 

3. From the SIMATIC Manager's File menu, select "Open..." 
 

4. When the "Open Project" dialog appears, select the "Libraries" tab 
 

5. From the list, select "gp8x0d“.  A list of objects will appear in the window on the 
right. 
 

6. Double-click the object named "Symbols“. 
 

7. From the window that appears select "Export“ from the Symbol Table menu. 
 

8. From the dialog that appears, select a folder (recommended folder: 
c:\siemens\sinumerik\symbols: [default for SIMATIC symbols export]). 

9. Provide a filename 
 

10. Click "Save". 
 

11. Proceed to one of the two following procedures on the next page. 
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Updating PLC VDI Symbols: Avoid this procedure unless you have installed a 
version of the 810D/840D(i) Toolbox newer than 6.4.  This procedure will take 
several minutes in the TSIW, and several minutes of additional time in SinuCom 
NC Trace after the TSIW completes.  After performing the procedure for PLC 
Symbols on the previous page, these symbols can be prepared for export from the 
machine environment via the following procedure: 
 

! Caution 

The two procedures on the preceding page must have been performed or this 
procedure will fail. 
 

 
 
1. From the Windows® desktop, launch the SIMATIC Manager by selecting 

"Start", "Programs", "SIMATIC", then "SIMATIC Manager". 
 

2. From the SIMATIC Manager's File menu, select "Open...".. 
 

3. When the "Open Project" dialog appears, select the "Libraries" tab. 
 

4. Select the library named "gp8x0d64" (or other desired library version [ex: 
gp8x0d71]), then press "OK".  A new dialog with a project tree on the left will 
appear. 
 

5. From the project tree, select "Sources". 
 

6. Right-click the object named "nst_udtb".  (This is the object that contains the 
PLC VDI symbols.) 
 

7. From the context menu that appears, select "Export Source...". 
 

8. Select the c:\siemens\sinumerik\symbols folder in which to save nst_udtb.AWL 
(English) or nst_udt.AWL (German).  Note this location, since the TSIW will be 
set up to search here for the PLC VDI symbols. 
 

9. Click "Save".  The PLC VDI Symbols are now ready for import. 
 
 
Updating PLC OEM Symbols:  After performing the procedure for PLC Symbols 
on the previous page, these symbols can be prepared for export from the machine 
environment via the following procedure: 
 

! Caution 

The two procedures on the preceding page must have been performed or this 
procedure will fail. 
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1. From the Windows® desktop, launch the SIMATIC Manager by selecting 

"Start", "Programs", "SIMATIC", then "SIMATIC Manager". 
 

2. In the SIMATIC Manager application, select "File", "Open", and then select the 
desired PLC project. 
 

3. Double-click the compiled logic block for which you wish to export Trace 
symbols. 
 

4. From the LAD editor ("LAD, FBD – Programming S7 Blocks.") select "File", 
"Generate Source" from the File menu.  The new dialog will appear. 
 

5. In the "Object Name" box, key in the name of the source file that will contain the 
desired PLC OEM symbols, then press "OK". 
 

6. The "Generate source <object>" dialog will appear. 
 

7. Highlight the blocks in the "Blocks Not Selected" window that contain the 
symbols to be imported, then use the right arrow to move these blocks to the 
"Blocks Selected" window.  Make sure the "Symbolic" option is selected. 
 

8. Activate the SIMATIC Manager (click on it). 
 

9. From the project tree, select "Sources". 
 

10. Right-Click the new Source file in the list. 
 

11. From the menu that appears, select "Export Source...". 
 

12. Select the c:\siemens\sinumerik\symbols folder. 
 

13. Click "Save".  The PLC OEM Symbols are now ready for import. 
 

Importing the Symbols 
Once symbols are prepared for import (as described above) the Trace Symbol 
Import Wizard can be invoked from SinuCom NC through the following procedure: 
1. If SinuCom NC Trace is not already running, start Trace from SinuCom NC (as 

described in "A Hands-On Example"). 
 

2. Select "File" from the main menu. 
 

3. Select "Import Symbols...".  The Overview screen will appear, indicating if any 
symbols now exist in the NC that have not yet been imported into SinuCom NC. 
 

4. Select "Next".  The user is then asked if a Custom or an Express Import is to be 
performed. 
 

5. Select "Express Import". 
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6. For PLC symbols, the "Include PLC Symbols" check is made available by typing 
the name of the PLC folder (only if the symbols are located in a folder othere 
than the default).  Typing an invalid folder or one with no symbols invalidates 
the "Include PLC Symbols check box. 
 

7. Click Finish 
 

8. When the procedure completes the wizard disappears.  The new symbols are 
now available for use in SinuCom NC Trace. 

 

Express versus Custom Import 

 Note 

An Express Import is recommended to reduce the complexity of this procedure. 
 

 
Express Import: Prepares the wizard to accept all default selections, and to import 
PLC symbols from the specified folder. TSIW will disable the "Include PLC sym-
bols" checkbox if the folder specification is incorrect or the folder does not contain 
the required symbol files (reference "How to Make Symbols Available for Import"). 
The "Browse" button can be used to correct the folder specification. Clicking the 
"Finish" button proceeds directly to the Summary screen and starts the import 
process. However if there is nothing for the Wizard to do, only the Cancel button 
will be available. 
 
Custom Import: Allows users to decide whether to import GUDs and which kind of 
PLC symbols to import. This is only recommended for users who need a greater 
degree of control over what symbols are added into the database. Clicking the 
"Next" button advances the dialog to Global User Data. 
 
The following screens apply only to the "Custom" selection: 

• Global User Data 
• PLC Variables 

 
 
Global User Data 
If there are GUDs available for import, this selection on the left of the screen is ac-
tive. Selecting it yields a list of any GUDs available for import (if any). (Note that the 
wizard will display only GUD categories with defined GUDs. For example when 
there are no GUDs in a category, the category is skipped) Each GUD displayed 
might have available GUDs for "Channel", "General", both or neither. 
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PLC Variables 

 Note 

Typically PLC VDI symbols are already installed.  The mention of PLC VDI 
symbols only applies when a version update is required. 
 

 
If there are either PLC VDI or PLC OEM variables available for import, the "PLC 
Variables" selection on the left of the screen is active. Import of these two variable 
types is identical. Thus, they are loaded at the same time with the same tool. 
 
In addition to allowing the user to select a pertinent folder or project file (first two 
buttons), the following selections allow the user to specify the types of symbols to 
be imported: 
 

 Note 

The following choices appear on the "General" tab: 
• Import I, Q, M symbols 
• Import User DB symbols  

 
 
When a user prepares VDI Symbols for upgrade, the "Advanced" tab becomes 
available.  Using this tab requires prior selection of Import I, Q, M symbols.  
Clicking the "Advanced" tab reveals the following additional choice:  

• Import PLC-NC Interface (VDI) symbols. 
 
After the choices above have been made, any new PLC variables available for 
import are displayed. 
 
 
Summary Screen 
Prior to exiting the TSIW, the Summary Screen confirms the choice of symbols for 
import, and displays progress as it creates the database files to be used by 
SinuCom NC Trace. When importing activites complete, the TSIW dismisses itself. 
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4.10.8 Trace Setup Wizard (TSW) 
SINUMERIK 840D Trace must be properly configured to support SinuCom NC 
Trace and the SI Acceptance Test. 
 
The TSW provides two choices for configuration: 

• EXPRESS (to minimize the required steps, yet still provide a typical 
configuration). 

• CUSTOM (for experts, who wish to fine tune the configuration). 
 
If a message box suggesting use of the TSW appears at startup, an unsuitable 
configuration is present.  The TSW must be run in this case. 
 

 Note 

A startup check is performed by SinuCom NC Trace (Trace) and SI Acceptance 
Test for minimum Trace resources.  A message box appears if this test fails.  If 
this occurs, use the Trace Setup Wizard (TSW) to configure the Trace 
applications that you want to run.  After successfully running the TSW, SinuCom 
NC Trace applications will start up without interruption. 

 
Previous releases of SinuCom NC relied on the user to locate and modify 
configuration items according to the "read me“ file. The TSW, new with V06.04, 
streamlines the configuration process. TSIW applies the default configuration for 
trace resources with minimal user effort. 
 
To start the TSW from the SinuCom NC opening screen:  

• Select "Open Online Project" from its toolbar button or the "Target Syst." 
menu. 

• Expand the SINUMERIK folder and double-click on the machine data block 
(e.g., "MD-block 1"). 
Ensure that the "Display Dialog" (not the Expert List) is active. 

• Click on "Trace Setup Wizard" in the project tree. 
 

Overview Dialog 
The Overview Dialog is the opening screen for the TSW.  It describes the current 
state of the system’s Trace Server and NCK configuration according to the 
selected trace applications. This shows whether the currently configured trace 
applications are consistent with the current NCK configuration and NCK version. 
 
The Overview displays the connected NCK’s name, version number, and current 
SRAM and DRAM utilization. 
 
The Overview also shows the status of each configured application. A green check 
mark ( ) icon indicates that the current configuration supports the running of this 
application. A red "X" means that this application cannot run with the current 
configuration.  
 
Along with the red "X", a “Results” button appears. Pressing this button describes 
why the application won’t run with the current configuration.  
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Setup Method Dialog 

 Note 

Express Setup is recommended to reduce the complexity of this procedure. 
 

 
Express: Prepares the wizard to accept all default selections.  Clicking the "Finish" 
button proceeds directly to the Summary screen and starts the setup process.  
However, if the Wizard finds nothing to do, only the Cancel button will be available. 
 
Custom: Allows users to decide whether to provide specific values for resource 
allocations.  This is only recommended for users who want a greater degree of 
control over the settings for individual trace application.  Clicking the "Next“ button 
proceeds to the applications list. 
 
The following screens are available only in Custom Setup mode: 

• Trace Applications List. 
• SinuCom NC Trace 
• Generic Trace Client 
• Advanced Features 

 
 
Trace Applications List 

 Note 

Warning text indicates if an earlier NCK version will not allow the SI Acceptance 
Test to run. 

 
The Trace Applications List provides information to balance the available trace 
resources among the SinuCom NC applications. Therefore, it is best not to click 
"Yes" for an application unless you have a known need to run it. 
 
There is also a choice between sharing slots or configuring multiple slots.  Each 
allocated slot corresponds to a resource that hosts a trace recording session.  SI 
Acceptance Test uses only one recording session, but SinuCom NC trace can use 
more than one recording session.  SinuCom NC Trace can start a recording 
session and switch to another.  Simultaneous use of multiple trace recording 
sessions is an advanced feature. 
 
Slot allocation selections are: 

• One shared slot for all applications. (This is only choice for earlier NCK 
versions.) 

• Multiple slots to be shared for all applications.  
 

 Note 

A configuration page is provided for Trace and Generic applications.  Generic 
applications are optional and are not available in most cases. 
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 Note 

A configuration page is not presented for the SI Acceptance Test because its 
requirements are fixed. 
 

 

Common General Configuration Items 
These items are available for fine tuning SinuCom NC Trace and Generic 
applications. Please avoid changing these values unless you need to customize 
your settings. The Summary section can be skipped if performing an "Express 
Setup“. 
 

• Maximum simultaneous sessions: Total user slots required by this 
application.  Slots should be used sparingly to avoid impairing other control 
functions. 

• Maximum standard unique data lists: (memory) Total standard events.  
Each combination of a different standard event and NCK data item 
requires one list. Reference: MD 18371, 
MM_PROTOC_NUM_ETPD_STD_LST. 

• Highest standard event ID: (memory) highest event number used.  
Normally all standard events should be included.  Reference: MD 28302, 
MM_PROTOC_NUM_ETP_STD_TYP. 

• Maximum OEM unique data lists: (memory) Total OEM events.  Each 
combination of a different OEM event and NCK data item requires one list.  
Reference MD 18372, MM_PROTOC_NUM_ETPD_OEM_LST. 

• Highest OEM event ID: (memory) Highest NCK OEM event number.  
Reference: MD 28301, MM_PROTOC_NUM_ETP_STD_TYP. 

• Maximum simultaneous servo signals: (memory) Total servo data items 
per session. Reference: MD 18373, MM_PROTOC_NUM_SERVO_DATA. 

 

Common Advanced Configuration Items 

• Amount of data stored in the NCU SRAM/DRAM log file: Maximum file size 
for the NCK log file.  Data loss occurs when the logged data exceeds this 
size prior to being offloaded to the HMI.  Corresponds with TraceSrv.ini key 
nckFileSize.  Note deferred offloading overrides this size with the value 
specified for a Trace. 

• Amount of data stored in the HMI hard drive log file: Maximum size for the 
log file offloaded to the HMI’s hard drive.  If the session’s total amount of 
data logged exceeds this size (without a client consuming the data), data 
loss occurs.  Corresponds with TraceSrv.ini key "HmiFileCapacity".  Note If 
a session disables deferred offloading, the size in the session overrides 
this. 

• Amount of data cached to the HMI RAM Frame: Maximum data memory 
for logging that is cached for quick client access on the HMI.  This 
allocation uses the OS virtual memory pool, and thereby affects other 
applications running on the CPU.  Corresponds with TraceSrv.ini key 
"HmiFrameCapacity". 
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• Size of the NCK Trace Logging Buffer: Size of the FIFO buffer on the NCK 
that spools captured data to the NCK Log File.  Determines the memory 
resource allocation on the NCK.  Decreasing the size can cause data loss.  
Reference: MD 18374, MM_PROTOC_FILE_BUFFER_SIZE. 

• Type of NCK Memory used for log data file: Selects SRAM or DRAM for 
the NCK Trace log file.  Reference: MD 11295, PROTOC_FILE_MEM. 

 

SinuCom NC Trace 
SinuCom NC Trace has requirements that vary with each session.  A minimal 
resource allocation is provided by default  
 

Generic Trace Client 
The Generic Trace Client does not appear in most installations.  If it does appear, 
there are a few unique configuration details: 
 

• Application Name: Text string user name displayed for generic trace 
application. 

 
• Generic Trace Client Name: Text string representing the key used to 

identify the application in the TraceSrv.ini file. 
 

Advanced Features 
The Trace Setup Wizard advanced features page provides entries for expert 
configuration of Trace services.  Some items represent resources that are shared 
by multiple applications.  For these items, the current values and the required 
values are displayed.  The user can override the required values or accept the 
calculated value. 
 

• Amount of data storage in the NCU SRAM/DRAM Log: Maximum file size 
for the NCK log file.  Data loss occurs when the logged data exceeds this 
size prior to being offloaded to the HMI.  Corresponds with TraceSrv.ini key 
nckFileSize.  Note deferred offloading replaces this size with the value 
specified for a Trace. 

• Amount of data stored in the HMI hard drive log file: Maximum size for the 
log file offloaded to the HMI’s hard drive.  If the session’s total amount of 
data logged exceeds this size (without a client consuming the data), data 
loss occurs.  Corresponds with TraceSrv.ini key HmiFileCapacity. 

• Amount of data cached to the HMI RAM Frame: Maximum data memory 
for logging that is cached for quick client access on the HMI.  This 
allocation uses the OS virtual memory pool, and thereby affects other 
applications running on the CPU.  Corresponds with TraceSrv.ini key 
HmiFrameCapacity. 

• Required User Slots: The number of NCK Trace user slots required to 
support the currently configured applications.  If the slot range is not 
correctly specified a session may not be hosted by the NCK because of 
slot limitations. 

• Lowest valid trace user slot: This is the lowest user slot that can be 
reserved by the Trace Server for use. Corresponds with TraceSrv.ini key 
LowestUserSlot.  
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 Note 1 

This item, in conjunction with the highest user slot, determines the valid range of 
NCK Trace user slots available for use by the Trace Server and its client 
applications. 
 

 

 Note 2 

User slots 1,2, and 3 are reserved for use by Siemens applications. 
 

 
• Highest valid trace user slot: Highest user slot that can be reserved for 

use. Corresponds with TraceSrv.ini key HighestUserSlot. 
• Trace Server stays alive when no client exists: Prevents the Trace Server 

from shutting down when no client applications are running.  Corresponds 
with TraceSrv.ini key KeepTraceSrvAlive. 

 

 Note  

If the Trace Server is kept running, only system shutdown will terminate the 
server. This may present problems if other HMI Base servers are terminated. 
 

 
• Maintain NCU Trace diagnostic file: Causes the Trace Server to create and 

maintain an NCK Trace Diagnostic file on the NCK. The file: 
SIEMPROTOKSTATUS.MPF is maintained in the MPF directory. The 
diagnostic file records configuration and memory utilization data that can 
be used for problem diagnosis. Corresponds with TraceSrv.ini key 
RetainTraceDiagnosticFile.   
Note Feature, not currently supported. 

 

Summary Screen 
The Trace Setup Wizard transitions to the summary page when the user presses 
the “Finish” Button. The summary page indicates progress through the 
configuration list with an arrow that appears next to each completed item. The 
process suspends if an NCK reset or NCK memory archive is required.  Continue 
the process by pressing the "Execute..." button on the SinuComNC tool bar.  
 
When setup activites complete, the TSW returns to the Overview Dialog. 
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4.11  Safety Integrated Acceptance Test Wizard 

(for SinuCom NC Version 06.03.09) 

Background and Definitions  
EC Machine Directive EN954-1 (Control Category 3) requires the original 
equipment manufacturer (OEM) to: 
• run acceptance testing on safety-relevant functions and machine parts. 
• generate an "Acceptance Test Certificate" showing the test results. 
 
The Safety Integrated Acceptance Test Wizard ("SI Wizard") is a "front end" 
designed to accomplish the above tasks. It eases the work of the OEM by: 
• Providing a standard way of adding the needed safety measures through the 

use of a user interface which has the look and feel of other components within 
SinuCom NC. 

• Minimizing the number of steps involved in performing a given test. 
• Integrating/automating the test instructions, test actions, collection of data and 

generation of the Acceptance Test Certificate in "wizard format". 
• Allowing the user to determine pass/fail status of each test (i.e., the decision-

making process is not automated). 
• Making the test results easy to view, clear and repeat as desired. 
• Eliminating the addition of unnecessary sensors, wiring and software. 
 

Compatibility with Siemens Software 
SinuCom NC – Must be version 06.03.07 or later. 
NCK – Must be version 06.04.11 or later. 
 

Acceptance Test Certificate 
The Acceptance Test Certificate is generated in the same language that has been  
selected as the SinuCom NC UI language. It is produced as a file in Rich Text 
Format (RTF). RTF is a standard format compatible with many text editors, includ-
ing MicroSoft Word®. 
 
 

4.11.1 A Hands-On Example: 
The easiest way to learn about the SI Wizard is to actually use it. This section illus-
trates the basic use of the tool in step-by-step fashion. 
 
1. Activate SinuCom NC. 
 
2. Click "Diagnosis" in the SinuCom NC main menu. 
 
3. Click "SI Acceptance Test" in the Diagnosis menu. The "Introduction/ Overview" 

Screen will appear.  
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4. Key in representative data in the fields on the right side of the screen. Entries 
made here describe the test environment, and will ultimately appear on the Ac-
ceptance Test Certificate.  Field descriptions are as follows: 

• Machine designation – The machine name (e.g., "Polaris 9000"). 
• Machine type – The kind of machine (e.g., knee mill). 
• Serial number – The unique serialized number assigned to the machine 

by the OEM. 
• Manufacturer – The machine maker, or OEM. 
• PLC version manufacturer – The manufacturer of the PLC. 
• Ultimate customer – The end-user of the machine. 
• Name of tester – The person running the test. 
• Series machine startup – Check if the machine is part of a production 

run of similar machines. 
• "Safe programmable logic" – "SPL" is a pair of independent, redundant 

code modules that monitor safety-related sensors. One module resides in 
the NCK. The other resides in the PLC. The results of one module are 
continually compared with the other. For additional information, refer to 
DocOnCD and search for "SPL". 

 
5. Click "Functional Relationships" in the List of Tests on the left side of the 

screen. The "Summary Functional Relationships" screen will appear. 
 
 

Note 

"Functional Relationships" was chosen for this example because it is a basic 
type of test. It simply allows manual entry of any test, and the results of the 
test. 

 
 
6. Click the "Begin This Test" button. The "Results New Test" screen will appear. 
 
 
7. Note that a "New Test" has been added to the List of Tests under "Functional 

Relationships". 
 
8. Click the "Continue Test" button. The "Results New Test" screen is now 

updated to allow tester to perform any test that is desired. The tester can 
manually name the test, and and can document the Test Trigger Condition and 
Result in the fields provided. The name given to the test now appears in the List 
of Tests. 

 
9. Select "Click here if functional test valid". The test is now marked as "passed 

(green check). 
 
10. Click the "Finish" button near the bottom of the screen. The "Finished" screen 

will appear. 
 
11. Click the "Generate Certificate" button. Because the test suite for this example 

is not complete, a prompt asking if a partial certificate will appear. 
 
12. Click "Yes". A standard Windows® "Save" dialog box will appear. 
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13. Key in a path and filename and click the "Save" button.  he saved file is the 
Acceptance Test Certificate. View its contents to complete this hands-on 
example. 

 
 

4.11.2 Common Screen Contents 
All SI Wizard screens consist of two major display regions: 

• A Selection/Status Pane (i.e., the List of Tests on the left) 
• A Dialog Pane (i.e., the area on the right). 
 

The following features are found at the top of each screen: 
• The Test Title (e.g., “Wiring Cross Check Test”), or Welcome Message for the 

Introduction/Overview screen. 
• The screen type (e.g., Introduction/Overview, Summary, Running Test, 

Results, or Finished). 
• A prompt below the Test Title or Welcome Message  that contains context-

specific instructions for user action. 
 
The "Next Page", "Previous Page" and "Finish" buttons appear at the bottom left. 
They are useful for navigating within and among tests. 
 
Buttons for Cancel and Help appear at the bottom right. 
 

 Note 

The Cancel button terminates the wizard, but may request further confirmation 
before termination is allowed. 
 

 

The Selection/Status Pane 

 Note 

Starting with V06.04, Custom Templates are accommodated in the 
Selection/Status pane by: 

- a new line above the tree view that displays the name of the active 
template.  (If there is no active template, there is no line.) 

- the addition of a "Template Information" page. 
Template tests are populated in the tree view as test result entries. For more 
information about template tests, see "Custom Templates". 
 

  
The Selection/Status pane (left side of initial screen) has two main functions: 
• Display of status information pertaining to individual tests and the overall 

acceptance test. 
• Navigation between test steps and between test results. 
 
Initially, this list contains one entry per test step with a final entry, “Finished”, used 
primarily for status. 
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Tests are displayed under the appropriate test step as they are invoked. They 
appear in one of three states: 
 
• Enabled Tests – Tests that are appropriate for the machine type and must be 

run. 
 

• Disabled Tests – Tests that are inappropriate for the machine type and 
feature content and cannot be run.  (I.e., tests that require Safe Programmable 
Logic are unavailable if that feature is not present.) 
 

• Deselected Tests - Tests that have been specified as not applicable for the 
current machine configuration by the user.  Tests are deselected by navigating 
to the individual test and then deselecting the test by checking a checkbox on 
the test summary screen. 

 
As tests are performed, the list is modified to show the status of individual tests. 
Figure 4-9, below, is an example of the results of three tests: 
• “Test1” (passed, "Pulse Disable Path" step). 
• “Operator Door” (passed, "External Stops" step). 
• “Tool Chain Door” (failed, "External Stops" step). 
 

 
Figure 4-9 Status Display with Test Results 
 

 Note 

Status of a given test is displayed as an indented entry that appears beneath the 
corresponding test step. If a test involves multiple test sequences and results, the 
individual results are added in the order they are run. 
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The status of each test is indicated by one of the following icons: 
 

 Test has been run and has passed. 

 Test has been run and has failed. 

 Test is currenty being run. (I.e., test is incomplete). 
 
 
The tester can take action on the test results by right clicking anywhere within the 
Selection/Status display. A window appears that offers the following choices: 
• Load Test Results... (allows previously-recorded test results to be retreived 

from a file). 
• Save Test Results... (allows current test results to be stored in a file). 
• Reset All Tests (erases all current test results). 
 
The last entry in the List of Tests is labeled “Finished”. Initially, this entry is 
disabled (greyed) and is enabled upon completion of at least one iteration of each 
of the tests (regardless of pass/fail status). 
 

The Dialog Pane 
The Dialog Pane (right side of initial screen) contains interactive information that is 
specific to the test that has been selected in the Selection/Status Pane.   
 
Since most tests have similar operational steps (i.e., setup, induce the failure, and 
verify the results) each of the dialogs has generally the same operational model. 
Each test is typically represented by three screen types: 
 
 
• Test Summary Screen – Describes the purpose, procedure, and any warnings 

associated with the test. Pressing the "Begin This Test" button advances the 
dialog to the "Running Test Screen". 
 

• Running Test Screen – Provides a step-by-step series of prompts such as: 
- Establish initial conditions (e.g., select the appropriate axis, etc.) 
- Start the test (will also auto-start the data collection) 
- Terminate data collection (automated if possible) 
- Select data to be saved 
- Restore initial conditions (usually a prompt for the operator to restore the 

machine) 
 

 Note 

One or more steps may be automated, and thus may not appear. 
 

 
Each step of each step has colored a number box with the following color code: 
 
Green box - indicates a completed step. The user cannot progress to next step 
without completing the current step. 
 
Yellow box - indicates the current step.  The prompt that appears in the display 
area at the top of the dialog applies to this step. 
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Gray box - indicates an upcoming step. 
 
 
• Test Results Screen – This screen: 

- Allows manual entry of the pass/fail status of the test. 
- Allows entry of observations for test results, if required. (Prompting that 

includes the captured data from the Running Test screen may occur.).  
- Provides a “Repeat This Test” button at end of test, if appropriate. 
- Provides a “Delete Test Results” button at end of test, if appropriate. 

 

 Note 

If "Repeat This Test" is selected, results from the current test are NOT discarded. 
(Test data is discarded only when "Delete This Test" is selected.) Repeating is 
appropriate when the same test is run multiple times with different commissioning 
(e.g., tests performed on multiple I/O points or axes.) 
 

 

The Alarm Display 
There is a new alarm display for V06.04.  The table format allows each alarm to be 
saved via checkbox.  Three types of collected alarms are available via tab 
selection: 
 

• "Collected" Alarms - All alarms that were detected during the running of the 
tests. 

 
• "Unexpected" Alarms - Collected alarms specified in the template as 

"MustNotOccur". 
 

• "Missing" alarms - Alarms specified in the template as "MustOccur", but did 
not occur. 

 
"Unexpected" alarms are always shown in both the list of "Collected Alarms" (in 
red), and in the list of "Unexpected Alarms". 
 

Repeat Same Test 
This is a new feature in V06.04. Through the "Repeat Same Test" button on the 
Results page, the user can now create a new test with the same commissioning 
settings as the prior test. 

 Note 

This button does not appear when operating with a template since new tests are 
not allowed when a template is active. 
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4.11.3 Other Tests 
A variety of tests can be run using the SI Wizard. These are listed in the 
Selection/Status Pane. They run in a fashion similar to that illustrated in the Hands-
on Example, but are typically more structured than the example. By following the 
steps outlined in each test, appropriate results will be obtained for the Acceptance 
Test Certificate. 
 
 

4.11.4 Custom Templates 
Custom templates (also known simply as "templates") are new in V06.04. A custom 
template is an XML file that contains all the information necessary to run its 
preconfigured set of Acceptance Tests. The set of tests that a template executes 
can be made up of any of the test types currently supported by the SI Wizard (e.g., 
SBH, SG, SE, etc.). These custom templates are typically created by expert users; 
however, use of the template allows the operator to focus more on the nature of the 
SI Acceptance Test process rather than the intricacies of the software tool. 
Because of the attributes of less data entry, fewer decisions and more prompting, 
the two primary benefits of the template are: 
 

• Ease of use by the novice. 
 

• Acceptance testing of high volume, similar machines. 
 

Facts About Custom Templates 
• Loading a custom template creates a "template test". 

 
• Templates are language-specific.  To switch languages, a new template 

file must be selected. 
 

• A "Not Tested" template test can be identified in the List of Tests by a blue 
exclamation point.  As the test is run, it transitions through the same states 
as a normal test. 

 
• A template test cannot be deleted (and cannot be removed from the results 

list) as long as it is loaded.  When a template test is reset, it returns to its 
"Not Tested" state. 
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• The user cannot create any new tests while a template is active. 
 

• If a template does not have a certain type of test (e.g., SE, SPH), that test 
type is removed from the tree view. 

 
• When a template test is clicked, the navigation follows the current state of 

the test.  (E.g., if it is "Not Tested", navigation goes to the Summary Page; 
if it has "Passed" or "Failed", navigation goes to the Results Page.) 

 
• Running a template is much the same as running a normal test, except that 

the data entry for test commissioning and test documentation are skipped.  
(This was done when the custom template was created.) 

 
• Commissioning information and documentation are displayed, but are not 

modifiable.   
 

• Data entry steps are removed.  The remaining steps are renumbered (i.e., 
1...n). 

 
• When a template test is completed, the user is required only to enter the 

pass/fail status of the test. 
 

• If a template is reset, its results are deleted and its state is reverted to "Not 
Tested" 

 
• Generation of the Acceptance Test Certificate is largely the same when 

using a template; however, there are multiple options for what to include in 
the document for tests that have not been run. 

 
 

Customized Test Prompts 
 To provide more meaningful instruction, texts supplied by the template file replace 
default text in the user interface.  If a text is not supplied, the default text is used. 
 
The following texts can be overridden: 
• Summary Page Procedure - This replaces the text that appears under the 

"Procedure" portion of the Test Summary. All 
other texts remain as their default setting. 
 

• Test Step Specific Prompt - This replaces the instructional text at the right 
of the test step indicator. 
 

• Data Collection Dialog 
Prompt 

- Appears on the Data Collection Dialog. It 
instructs the user to initiate the test condition. 
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Loading a Custom Template 
There are two mechanisms for loading a template: 

• The "Load Template..." button on the "Template Info..." page. 
• The "Load Template..." menu item in the context menu of the SI Wizard 

"Selection/Status" page. 
 
Selection of either choice presents a Windows® "File Open" dialog with a filter set 
to show template (i.e., .xml) files. 
 

 Note 

If there are results present when the user attempts to load a template, a message 
box is displayed that indicates that the results will be lost if the template is loaded.  
The load operation can be either canceled or completed. 
 

 

Unloading a Custom Template 
There are two mechanisms for unloading a template: 

• The "Unload Template" button on the "Template Info..." page. 
• The "Unload Template" menu item in the context menu of the SI Wizard 

"Selection/Status" page. 
 
Unloading a template causes the following to occur: 

• All tests in the template with the state "Not Tested" are removed. 
• All tests in the template with the state "Passed" or "Failed" are retained 

(including the contents of the "Overview" page). 
• The contents of the "Template Info" page are changed to show that a 

template is not active. 
• The template indicator at the top of the SI Wizard "Selection/Status" pane 

is removed.  
• All test prompts are reverted to the default prompts. 
• Functionality of the SI Wizard returns to normal operation. (I.e., the user 

interface is no longer locked down, tests can be created/deleted, etc.) 
 

Creating and Modifying Templates 
Templates can be created by: 

• Saving the results of a standard SI Wizard test as a template. 
• Modifying an existing template, then saving it in as new XML file. 
• Starting from scratch using the "CT Editor". (See "The Custom Template 

("CT") Editor") 
 

 Note 

Technically, a new template could be created by writing XML code, but this is not 
recommended. 
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Templates can be modified by: 
• Using a program called the "CT Editor" (recommended). 
• Directly modifying the XML code. 

 
Information on each of these methods is provided in the following sections. 
 

Saving Results as a Template  
A template can be exported from the SI Wizard as a custom template file by using 
the "Export" selection in the File Menu. The exported file contains the information 
for each test result, including all test commissioning data (e.g., axis selections, 
direction, etc.), and all test documentation data (e.g., trigger condition, tested 
circuit, etc.). The exported file will not contain any prompt information. 
 
For tests with alarm data, the collected alarms will be exported as "Must Occur" 
alarm entries. Exported alarm data is provided as a convenience to the user; 
however, it is not intended to be a complete solution, but rather a starting point for 
the created template. 
 

 Note 

This capability is not intended to fully allow a template to be created from an ex-
isting set of test results, but rather is intended as an aid in the conversion of exist-
ing results to a template file. 
 

 
 

The Custom Template ("CT") Editor 

 Note 

Use of the CT Editor requires that SinuCom NC V06.04 or later be installed, but 
not necessarily running. 
 

 
To start the CT Editor: 

1. On the Windows® Desktop, open the "SinuComNc" folder. 
2. Drag the CT Editor shortcut to the Windows® Desktop. 
3. Double-click on the CT Editor icon. 

 
When the editor is launched, the "Template Information" page appears.  This is the 
first indication that the editor's look and feel emulates that of the SI Wizard. In fact, 
all of the editing screens, for test entries, alarms, etc., closely emulate their 
corresponding entry screen in the product. 
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Menus: 
There are two sub-menus in the main menu: 

• the File Menu 
• the Action Menu 

 
The File Menu allows: 

• Creation of a new template 
• Opening an existing template 
• Saving a Template 
• Exiting the editor 

 
The Action Menu allows the adding or removal of tests. 
 
Right-clicking on any test type in the tree view yields a pop-up menu identical to the 
Action Menu. 
 
 
Alarm Control: 
The following tests have alarms: 

• Pulse Disable Path 
• SPL Inputs/Outputs 
• Safe Operating Stops (SBH 
• Safely Reduced Speed (SG) 
• Safe Software Limit Switch (SE) 

 
Whenever one of these test types is added, three vertical boxes appear on the 
right side of the screen, each with "Add Alarm" and "Remove Alarm" buttons.  
These features allow the population of alarms in the following three categories: 

• Must Not Occur 
• Must Occur 
• Filtered (i.e., unimportant alarms to be excluded from the tests) 

 
It is an error to include: 

• the same alarm in both the "Must Occur" and "Must Not Occur" lists. 
• "Must Occur" or "Must Not Occur" in the "Filtered" list. 

 
 
Limit Checking of Test Results 
The user can optionally supply test-specific limit values against which test results 
can be checked.  Limits and actuals are displayed on the Results page.  If the limit 
is violated, the data is displayed in red. 
 
 
Saving the Template 
After configuration of the Custom Template is completed, the editor creates the 
.XML template.  The "Save" function allows preservation of the template in a fash-
ion similar to other Windows® applications. 
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XML Structure of the Custom Template 

 Note 

Direct modification of XML code is not recommended.  However, it can be per-
formed by expert users if necessary. This manual does not address the details of 
XML code modification. The user must already have this expertise to be success-
ful in performing this operation. 
 

 
This section documents the structure of the XML used for the SI Wizard custom 
template. This structure has four main architectural elements for the purpose of 
data organization and readability. The architectural elements are: 
 

1. The outermost tag (“<ATWCustomizingTemplate>”) grouping that encap-
sulates and identifies the XML as a custom template. This grouping con-
tains nested entries for each SI Wizard test category (Structure 1)and an 
entry for containing information pertinent to the custom template. 

 
2. A set of test type-specific XML structures, each of which contains a nested 

collection of XML structures that are used to configure individual test in-
stances (e.g., “<PulseDisablePathsTests>”, “<ExternalStopsTests>”, etc.) 
of a particular test type.(Structure 2 through Structure 11) 

 
3. Test type-specific XML structures that contain the data necessary for con-

figuring a particular test instance (e.g., “<PulseDisablePathsTestInfo>”, 
“<ExternalStopsTestInfo>”, etc.). These structures contain individual tags 
for each test item that can be configured by the custom template. (Struc-
ture 4 through Figure 11). 

 
4. An XML structure that is used to describe a list of SINUMERIK alarms 

(Structue 12)). This structure is used by the test type-specific entries to de-
scribe a grouping of alarms that are identified by their alarm id, axis, and 
channel.  These are used to specify the “Must Occur”, “Must Not Occur”, 
and “Filtered” alarm lists. 
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Overall Structure 
The following XML source code is referred to in item 1, above.  The items nested 
within the <ATWCustomizingTemplate> tag define the test content of the template. 
 
<ATWCustomizingTemplate> 
  <TemplateInfo> 
  </TemplateInfo> 
  <OverviewInfo> 
  </OverviewInfo> 
  <PulseDisablePathsTests> 
  </PulseDisablePathsTests> 
  <ExternalStopsTests> 
  </ExternalStopsTests> 
  <SPLInputOutputTests> 
  </SPLInputOutputTests> 
  <EmergencyStopsTests> 
  </EmergencyStopsTests> 
  <FunctionalRelationshipTests> 
  </FunctionalRelationshipTests> 
  <SafeStandstillSBHTests> 
  </SafeStandstillSBHTests> 
  <SafelyReducedSpeedSGTests> 
  </SafelyReducedSpeedSGTests> 
  <SafeSoftwareLimitsSETests> 
  </SafeSoftwareLimitsSETests> 
</ATWCustomizingTemplate> 
 
Structure 1: XML Structure - Overall 
 

Test Type-Specific Data 
This section shows the structure of the XML for Template Info page, Overview 
page, and individual test entries in the custom template. 
Template Info Page: 
  <TemplateInfo> 
    <TemplateName></TemplateName> 
    <ApplicationName></ApplicationName> 
    <AuthorName></AuthorName> 
    <CreateDateTime></CreateDateTime> 
    <ModifyDateTime></ModifyDateTime> 
    <Description></Description> 
  </TemplateInfo> 
 
Structure 2: XML Structure - Template Info 
 
Overview Page:  
  <OverviewInfo> 
    <MachineDesignation></MachineDesignation> 
    <MachineType></MachineType> 
    <Manufacturer></Manufacturer> 
    <PLCManufacturer></PLCManufacturer> 
  </OverviewInfo> 
 
Structure 3: XML Structure - Overview Info 
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Test of Pulse Disable Paths: 
  <PulseDisablePathsTests> 
    <PulseDisablePathsTestInfo> 
      <Name>Test Name</Name> 
      <Description>Test Description</Description> 
      <SummaryInstructions>Summary</SummaryInstructions> 
      <Prompt1>Prompt for Step 1</Prompt1> 
      <Prompt2>Prompt for Step 2</Prompt2> 
      <Prompt3>Prompt for Step 3</Prompt3> 
      <TestConditions>Test Conditions</TestConditions> 
      <PromptPass>Prompt Pass</PromptPass> 
      <PromptFail>Prompt Fail</PromptFail> 
      <MustOccurAlarms> 
      </MustOccurAlarms> 
      <CannotOccurAlarms> 
      </CannotOccurAlarms> 
      <FilteredAlarms> 
      </FilteredAlarms> 
    </PulseDisablePathsTestInfo> 
  </PulseDisablePathsTests> 
 
Structure 4: XML Structure - Test of Pulse Disable 
 
 
Test of External Stops: 
  <ExternalStopsTests> 
    <ExternalStopsTestInfo> 
      <Name>Test Name</Name> 
      <Description>Test Description</Description> 
      <SummaryInstructions>Summary</SummaryInstructions> 
      <AxisSelectionPrompt>AX1:X1</AxisSelectionPrompt> 
      <AxisSelection>AX1:X1</AxisSelection> 
      <AxisSelectionPrompt>Prompt for Axis Selection</AxisSelectionPrompt> 
      <CollectingDataPrompt>Prompt for Collecting Data</CollectingDataPrompt> 
      <Prompt1>Prompt for Step 1</Prompt1> 
      <Prompt2>Prompt for Step 2</Prompt2> 
      <Prompt3>Prompt3</Prompt3> 
      <TestConditions>Test Conditions</TestConditions> 
      <PromptPass>Prompt Pass</PromptPass> 
      <PromptFail>Prompt Fail</PromptFail> 
    </ExternalStopsTestInfo> 
  </ExternalStopsTests> 
 
Structure 5: XML Structure - Test of External Stops 
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Test of SPL Inputs/Outputs: 
  <SPLInputOutputTests> 
    <SPLInputOutputTestInfo> 
      <Name>Test Name</Name> 
      <Description>Test Description</Description> 
      <SummaryInstructions>Summary</SummaryInstructions> 
      <Prompt1>Prompt for Step 1</Prompt1> 
      <Prompt2>Prompt for Step 2</Prompt2> 
      <Prompt3>Prompt3</Prompt3> 
      <TestTriggerCondition>Test Conditions</TestTriggerCondition> 
      <PromptPass>Prompt Pass</PromptPass> 
      <PromptFail>Prompt Fail</PromptFail> 
      <MustOccurAlarms> 
      </MustOccurAlarms> 
      <CannotOccurAlarms> 
      </CannotOccurAlarms> 
      <FilteredAlarms> 
      </FilteredAlarms> 
    </SPLInputOutputTestInfo> 
  </SPLInputOutputTests> 
 
Structure 6: XML Structure - SPL Inputs/Outputs 
 
 
Test of Emergency Stops: 
  <EmergencyStopsTests> 
    <EmergencyStopsTestInfo> 
      <Name>Test Name</Name> 
      <Description>Test Description</Description> 
      <SummaryInstructions>Summary</SummaryInstructions> 
      <AxisSelection>AX1:B1</AxisSelection> 
      <AxisSelectionPrompt>Prompt for Axis Selection</AxisSelectionPrompt> 
       <SBHSHSelectionPrompt>Prompt for SH or SBH Selection</ SBHSHSelec-
tionPrompt > 
       <SHSelected>TRUE</SHSelected> 
      <CollectingDataPrompt>Prompt for Collecting Data</CollectingDataPrompt> 
      <Prompt1>Prompt for Step 1</Prompt1> 
      <TestedCircuit>Tested Circuit</TestedCircuit> 
      <CheckbackInput>Checkback Input</CheckbackInput> 
      <PromptPass>Prompt Pass</PromptPass> 
      <PromptFail>Prompt Fail</PromptFail> 
    </EmergencyStopsTestInfo> 
  </EmergencyStopsTests> 
 
Structure 7: XML Structure - Emergency Stops 
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Test of Functional Relationships: 
  <FunctionalRelationshipTests> 
    <FunctionalRelationshipTestInfo> 
      <Name>Test Name</Name> 
      <Description>Test Description</Description> 
      <SummaryInstructions>Summary</SummaryInstructions> 
      <Prompt1>Prompt for Step 1</Prompt1> 
      <TriggerCondition>Trigger Condition</TriggerCondition> 
      <PromptPass>Prompt Pass</PromptPass> 
      <PromptFail>Prompt Fail</PromptFail> 
    </FunctionalRelationshipTestInfo> 
  </FunctionalRelationshipTests> 
 
Structure 8: XML Structure - Functional Relationships 
 
 
Test of Safe Operating Stop: 
  <SafeOpStopSBHTests> 
    <SafeOpStopSBHTestInfo> 
      <Name>SBH - Test Iteration</Name> 
      <Description>Description</Description> 
      <AxisSelection>AX1:X1</AxisSelection> 
      <MotionIsPlusDirection>False</MotionIsPlusDirection> 
      <SummaryInstructions>Summary</SummaryInstructions> 
      <AxisSelectionPrompt>Prompt for Axis Selection</AxisSelectionPrompt> 
      <DirectionPrompt>Prompt for Directoin</DirectionPrompt> 
      <CollectingDataPrompt>Prompt for Collecting Data</CollectingDataPrompt> 
      <Prompt1>Prompt for Step 1</Prompt1> 
      <Prompt2>Prompt for Step 1</Prompt2> 
      <TestTriggerCondition>Trigger Condition</TestTriggerCondition> 
      <SpeedLimit>1200.00</SpeedLimit> 
      <OvertravelLimit>0.80</OvertravelLimit> 
      <ReactionTimeLimit>0.30</ReactionTimeLimit> 
      <PromptPass>Prompt Pass</PromptPass> 
      <PromptFail>Prompt Fail</PromptFail> 
      <MustOccurAlarms> 
      </MustOccurAlarms> 
      <CannotOccurAlarms> 
      </CannotOccurAlarms> 
      <FilteredAlarms> 
      </FilteredAlarms> 
    </SafeOpStopSBHTestInfo> 
  </SafeOpStopSBHTests> 
 
Structure 9: XML Structure - Safe Operating Stop (SBH) 
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Test of Safely Reduced Speed: 
  <SafelyReducedSpeedSGTests> 
    <SafelyReducedSpeedsSGTestInfo> 
      <Name>Test Name</Name> 
      <Description>Test Description</Description> 
      <AxisSelection>AX1:X1</AxisSelection> 
      <MotionIsPlusDirection>True</MotionIsPlusDirection> 
      <SGSelection>SG1</SGSelection> 
      <SummaryInstructions>Summary</SummaryInstructions> 
      <AxisSelectionPrompt>Prompt for Axis Selection</AxisSelectionPrompt> 
      <DirectionPrompt>Prompt for Axis Direction</DirectionPrompt> 
      <SGSelectionPrompt>Prompt for SG Selection</SGSelectionPrompt> 
      <CollectingDataPrompt>Prompt for Collecting Data</CollectingDataPrompt> 
      <Prompt1>Prompt for Step 1</Prompt1> 
      <Prompt2>Prompt for Step 1</Prompt2> 
      <TestTriggerCondition>Trigger Condition</TestTriggerCondition> 
      <SpeedLimit>1200.00</SpeedLimit> 
      <OvertravelLimit>0.80</OvertravelLimit> 
      <ReactionTimeLimit>0.30</ReactionTimeLimit> 
      <PromptPass>Prompt Pass</PromptPass> 
      <PromptFail>Prompt Fail</PromptFail> 
      <MustOccurAlarms> 
      </MustOccurAlarms> 
      <CannotOccurAlarms> 
      </CannotOccurAlarms> 
      <FilteredAlarms> 
      </FilteredAlarms> 
    </SafelyReducedSpeedsSGTestInfo> 
  </SafelyReducedSpeedSGTests> 
 
Structure 10: XML Structure - Safely Reduced Speed (SG) 
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Test of Safe Software Limit Switch (SE): 
  <SafeSoftwareLimitsSETests> 
    <SafeSoftwareLimitsSETestInfo> 
      <Name>Test Name</Name> 
      <Description>Test Description</Description> 
      <AxisSelection>AX1:X1</AxisSelection> 
      <SESelection>SE1</SESelection> 
      <MotionIsPlusDirection>True</MotionIsPlusDirection> 
      <SummaryInstructions>Summary</SummaryInstructions> 
      <AxisSelectionPrompt>Prompt for Axis Selection</AxisSelectionPrompt> 
      <SESelectionPrompt>Prompt for SE Selection</SESelectionPrompt> 
      <DirectionPrompt>Prompt for Direction</DirectionPrompt> 
      <CollectingDataPrompt>Prompt for Collecting Data</CollectingDataPrompt> 
      <Prompt1>Prompt for Step 1</Prompt1> 
      <Prompt2>Prompt for Step 2</Prompt2> 
      <TestTriggerCondition>Trigger Condition</TestTriggerCondition> 
      <SpeedLimit>1200.00</SpeedLimit> 
      <OvertravelLimit>0.80</OvertravelLimit> 
      <ReactionTimeLimit>0.30</ReactionTimeLimit> 
      <PromptPass>Prompt Pass</PromptPass> 
      <PromptFail>Prompt Fail</PromptFail> 
      <MustOccurAlarms> 
      </MustOccurAlarms> 
      <MustNotOccurAlarms> 
      </MustNotOccurAlarms> 
      <FilteredAlarms> 
      </FilteredAlarms> 
    </SafeSoftwareLimitsSETestInfo> 
  </SafeSoftwareLimitsSETests> 
 
Structure 11: XML Structure - Safe Software Limit Switch (SE) 
 
 

Alarm List Data 
The following documentation shows the format of the XML data for the specification 
of alarm list data.  Alarm lists are collections of <AlarmInformation> entries, where 
each entry describes an alarm by: 
 
Alarm Number  
Axis Identifier  optional (blank if no axis is involved) 
Channel   optional (blank if no channel is involved) 
 
An alarm list is empty if it contains no <AlarmInformation> entries. 
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Shown below is an example of an alarm list (<MustOccurAlarms>) that contains 
two alarm entries   
 
   <MustOccurAlarms> 
      <AlarmInformation> 
        <Number>27001</Number> 
        <Channel>Channel 1</Channel> 
        <Axis>AX1:X1</Axis> 
      </AlarmInformation> 
      <AlarmInformation> 
        <Number>19005</Number> 
        <Channel> Channel 1</Channel> 
        <Axis>AX1:X1</Axis> 
   </MustOccurAlarms> 
 
Structure 12: XML Structure - Alarm List 
 

 Note 

Alarm lists <MustNotOccurAlarms> and <FilteredAlarms> are identical in struc-
ture to the <MustOccurAlarms> list shown directly above. 
 

 
 

 
 

� 
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5.1  Operation 
The program SinuCom FFS is started by 
• clicking on the "SinuCom FFS" icon (Start menu or desktop) or 
• with SinuCom NC, menu "Tools -> SinuCom FFS"    
You can call up the various functions of the program from the menu bar or directly 
from the user interface using the buttons. Help is available for all actions that can 
be called up via the "Help" menu. 
 
 
 

5.2  Display of the NC image 
In the basic display the modules of the NC image are displayed with  
• name,  
• version,  
• date,  
• size and  
• checksum.  
 

Properties 
With menu items "View -> Properties" you can display 
• the contents of the serial number file or  
• the PCM version with which the image was generated.  
  
 
 
 

5.3  Displaying/editing the FFS image 
Irrespective of the SINUMERIK system software (NC), SinuCom FFS can 
• read, 
• change, 
• rewrite, 
• reformat the FFS range of the NC card 
• create new directories, 
• copy and insert a file in the directories and subdirectories (via the clipboard). 
You can call up the various functions of the program from the menu bar or directly 
from the user interface using the buttons. 
 

Displaying the FFS 
If the contents of the FFS image are not displayed in the right-hand window, the 
FFS image must be formatted with "Edit -> Format": In the "formattng window", you 
specify the start address, size, and file name.   
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Processing the FFS 
Once the FFS image is formatted, the menu items for creating files and directories 
are enabled.  
 

Exporting the FFS 
You can export (transfer) a formatted FFS image by selecting menu items "File -> 
Export": In the dialog box "Export to" you can specify the target and target directory 
to which the FFS image is to be exported.  
 

Importing the FFS 
To import the FFS image, select it in the left-hand window and start the function 
"File -> Import": In the dialog box "Import from" you can specify the target and 
target directory to which the FFS image is to be imported.  
In this case, the image does not have to contain an FFS. If one does exist, it is 
overwritten. 
 
 
 
 

5.4  Writing an NC image to NC card/Reading an NC image from 
NC card 

The system software (NC) can be  
• completely overwritten, 
• duplicated, 
• read out, and  
• stored as a file  
The version of the NC system of the inserted card is displayed when it is read out. 
 

Storage capacity of the NC card 
In order avoid storage capacity problems, you can specify the storage capacity of 
the NC card used under "View -> Options -> Card size". 
 

 Note 

You can duplicate entire NC cards (NC + FFS). 
 
 
 

� 
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6.1  Operation 
The program SinuCom ARC is started by 
clicking on the "SinuCom ARC" icon (Start menu or desktop) or 
with SinuCom NC, menu "Tools -> SinuCom ARC"   
You can call up the various functions of the program from the menu bar or directly 
from the user interface using the buttons. Help is available for all actions that can 
be called up via the "Help" menu. 
 
 
 

6.2  Displaying the contents of the archive 
As soon as an archive has been loaded, the files contained in the archive appear in 
the basic display together with the  
• name, 
• path 
• size. 
  

Properties (available soon) 
You can view file the properties with "View -> Properties". 
 
 
 

6.3  Editing the archive contents 

Processing the ARC 
With SinuCOM ARC you can 
• create new directories and files, 
• change directories and files, 
• copy and insert files/directories into the directories and subdirectories (via the 

clipboard), and 
• delete files/directories 
You can call up the various functions of the program from the menu bar or directly 
from the user interface using the buttons. 
 

Saving the ARC 
When the files of the archive file are complete, the archive file must be saved 
(upgrade archive: available soon). 
 

Exporting the ARC 
You can export (transfer) an archive file by selecting menu items "File -> Export": 
The dialog box "Export to" shows the target directory to which the archive file is 
exported.  
The same hierarchy is reproduced and the data are placed in the same hierarchy 
structure.  
At the same time the system automatically generates a standard import 
"description file" (see below). 
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Importing the ARC 
The ARC file is imported by selecting it in the window and then starting the function 
"File -> Import": The target and "description file" containing the import instruction is 
displayed in the dialog box "Import from".  
 

Description file 
For all ARC import actions, whether to an empty or existing archive, a description 
file containing the individual instructions for the import action must be specified. 
Each line of the file is read in and interpreted.  
Comments are either separated from the instruction itself by a ";" or stand alone in 
a line preceded by a ";" at the beginning of the line. The following commands are 
possible: 
"$$ROOT$$ = path name" : 
Path name: Absolute path within the file system of the operating system.  
Specifies the path from which all relative paths in the following instructions are 
located. This instruction can occur several times within a single file. 
 
"Path_nameOS = Path_nameArchive" : 
This instruction ensures that the content of Path_nameOS becomes the content of 
Path_nameArchive. Path_nameArchive is always an absolute path within the 
archive hierarchy in every instruction. Path_nameOS can be either a relative or 
absolute path.  
If Path_nameOS is a directory, Path_nameArchive is always interpreted as such, 
and the files and subdirectories of Path_nameOS are added to Path_nameArchive.  
The system attempts to create Path_nameArchive if it does not exist. If 
Path_nameOS is a file, Path_nameArchive must also assume a file name.  
The content of file Path_nameOS becomes the content of the file 
Path_nameArchive. If Pathname_Archive already exists, you are asked whether 
you want to overwrite the content. If the file does not yet exist, the program tries to 
create the file. 
 
Path_nameOS > Path_nameArchive" : 
With this instruction, Path_nameOS is placed in directory Path_nameArchive. 
Path_nameArchive is then always an absolute path to a directory in the archive. If it 
does not exist, the program tries to create it. Path_nameOS can be either a relative 
or absolute path. If Path_nameOS is a directory, the directory and all the data it 
contains (files and subdirectories) are placed in Pathname_Archive. If 
Pathname_OS is a file, it is entered in Pathname_Archive under the same name. If 
this file already exists, you are asked whether it should be overwritten. 
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6.4  Creating an archive 
Select "File -> New" to create a new empty archive into which you can put 
files/directories. 
 

Saving the ARC 
Once the files of the archive file are complete the archive file must be stored in 
Embedded or Advanced format.  
 
 

� 
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7.1  Operation 
The service tool SINUCOM PCIN is operated with the mouse or keyboard, the 
online Help is called up with the softkey "About" Æ "Help".  
 
 
 

7.2  Functions 

Configuring the RS-232 interface (softkey RS-232 Config) 
You can set the RS-232 interface according to your individual needs and the 
requirements of the connected device, softkey RS-232 Config (or F1) . When you 
press the softkey, the selection image showing the various parameters is 
displayed. You now select one of the four settings with one of the assigned keys. 
(softkeys shift F1 to shift F4).  
 
Flow control 
The flow control controls the serial communication (data transmission) between 
transmitter and receiver. Both a hardware and a software procedure exist:  
• XON and XOFF software procedure (handshaking) for flow control with serial 

data transmission. The receiver signals to the transmitter whether the data can 
be received (XON) or not (XOFF). 

• DTR / DSR and RTS / CTS: Hardware procedure (handshaking) for flow control 
with serial data transmission.  

 

 Note 

Wherever possible, hardware handshaking should be used as this is much 
quicker. 
 

 

Transmission with error detection and correction 
With SINUCOM PCIN you can activate the protocol Transmission with error 
detection and correction (ZMODEM): 
• High degree of error detection  
• If transmission fails, it is resumed again precisely at the point at which it was 

interrupted.  
• Adapts the size of the transmitted blocks to the transmission conditions.  
 
If an error occurs during transmission, transmission is not aborted. The protocol 
attempts to resume data transmission from the point of interruption. This happens 
automatically. After five failed attempts transmission is then aborted. 
 

 Note 

You can only activate transmission with error detection and correction with 
hardware handshaking RTS/CTS. 
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Sending/receiving data (SEND DATA/RECEIVE DATA) 
You send data with SEND DATA (or F3) and receive data with RECEIVE DATA (or 
F2). In both procedures, you enter the source and target file name after triggering 
the procedure from a menu. You can cancel transmission with ABORT Transfer (or 
F4). 
 

Editing data (Edit single archive file) 
Select a SINUMERIK archive file. A list of the files in this archive file is displayed. 
Double-click the selected file to transfer it to the editor where you can continue to 
work on it. Only individual files can be returned to the control. 
 

Saving individual files from directories (Split archive) 
All the files of the selected archive are stored as individual files as of this directory.  
 

Querying the RS-232 status window (Show RS-232 status) 
A  status line with the status signals of the RS-232 interface is displayed here. (Red 
-> no transmission possible // Green -> transmission possible) For an explanation 
of the signals see PIN functions under Interconnection diagrams. 
 
 
 

7.3  File WINPCIN.ini 
The tool SinuCom PCIN can also be parameterized by experts in the WINPCIN.ini 
file: 
The four possible settings enabled by pressing a key can be found in file 
WINPCIN.INI under User to USER3 or RS232_INI to RS232_INI3. 
[User]  ; or [User1];[User2];[User3] 
 
Both paths for upload and download can be preset. 
Upload path=c:\winpcin\updata   
Download path=c:\winpcin\downdata 
If a different path is selected for uploading or downloading during a SINUCOM 
PCIN "session", it remains valid for the duration of the program. 
 
Background=c:\v24\winpcin\myBild.jpg 
Here you can load your own logo image as a background. 
[RS232_INI] or [RS232_INI1] [RS232_INI2] [RS232_INI3]  
 
Softkey=USER  
Here you will find the softkey text. 
 
Bildschirm_aktiv=1 
(Screen active) displays the file content in a window, only for transmitting data 
 
EOF=0 ; 0 = deactivated 1=activated 
Data transfer is stopped as soon as the EOF character is received, or during 
transmission the EOF character (03h) is additionally sent. 



7 SinuCom PCIN: Functions 12.04 
7.3  File WINPCIN.ini 
 
 

 © Siemens AG 2004 All Rights Reserved 
7-124 SINUMERIK 840D/840Di/810D SYS Commissioning Tool SinuCom NC (INC) - 12.2004 Edition 

 
PortNumber=1 
 
Settings=19200,N,8,1 
This is where the serial interface is parameterized.  
The sequence is baudrate, parity , databit , stopbit  
Possible settings for baudrate : 300, 1200, 2400, 4800, 9600, 19200, 38400, 
57600, 115200 
Possible settings for parity : n=None;e=Even;o=Odd;m=Mark;s=Space 
Possible settings for number of data bits : 5 to 8 
Possible settings for number of stop bits : 1, 1.5, 2 
 
Handshaking=2 
This is where the transmission control is set.  
0=none No control -> in certain circumstances characters might be lost 
1=rtscts Control through two hardware lines 
2=xon/xoff Control through software together with two characters which can be 
transmitted to stop and continue transmission. 
 
Timeout=5 
Transmission is aborted after the set time. 
 
Protocol=5 
The data transmission protocol is set here 
Possible settings are PROTOCOL_ASCII = 0 or transmission with error detection 
and correction = 5 
 
The internal sizes of the input buffer or output buffer are set with the two variables  
InBufferSize= 1536‚ default value 
OutBufferSize= 2048‚ default value 
  
 
Under the heading 
[COMMON] you will find the interface parameterization to be activated directly after 
power up 
DEFAULT=0 ; corresponds to USER or RS232_INI 
 
 

� 
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A Appendix 

 

A.1  Abbreviations 
 
ASCII American Standard Code for Information Interchange: Amerikanische Code-

Norm für den Informationsaustausch 
 

ATW SinuCom NC SI Acceptance Test Wizard (a.k.a. "SI Wizard") 
 

BTSS Operator panel interface ("BedienTafelSchnittStelle") 
 

DB Data Block 
 

GUD Global User Data 
 

HMI Human Machine Interface 
 

IPO Interpolation Task 
 

LUD Local User Data 
 

MD, or MaDa Machine Data 
 

MDI Manual Data Interface 
 

NC Numerical Control 
 

NCDDE SINUMERIK HMI Base's MPI Communications Server (Numerical Control 
Dynamic Data Exchange) 
 

NCK Numerical Control Kernel 
 

NCU Numerical Control Unit (i.e., the real-time hardware) 
 

OEM Original Equipment Manufacturer 
 

PLC Programmable Logic Controller 
 

PUD Program User Data (a.k.a. Program Global Variables) 
 

SBH Test of Safe Operating Stop (SI) 
 

A
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SE Test of Safe Software Limit Switch (SI) 

 
SG Test of Safely Reduced Speed (SI) 

 
SI Safety Integrated 

 
SPL Safe Programmable Logic (SI) 

 
SRAM Static Random Access Memory 

 
SYNACT Motion Synchronous Action 
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A.2  Definitions 
Acceptance Test 
Certificate 

The certifying document that is the product of running the SI 
Acceptance Test. 
 

Acceptance Test Wizard 
 

Same as "SI Acceptance Test". 

Archive A backup of data (e.g., of SinuCom NC configuration data). 
 

Bit Mask A signed or unsigned integer (byte, word or dword) used to select 
only certain bits of information from a target integer. 
 

Copy (a waveform) The process of selecting a waveform and placing a duplicate on 
the Windows® clipboard.  Such a waveform can subsequently be 
pasted into a SinuCom NC Trace Session.  See also "Insert" and 
"Load". 
 

Custom Template An SI Acceptance Test XML file that contains all the information 
necessary to run its preconfigured set of Acceptance Tests.  
Same as "Customizing Template", or "Template".  See also 
"Template Test". 
 

Data A general term for stored values of any variable. 
 

Data Manager A facility within SinuCom NC Trace that collects and caches data 
from the Trace Server and formats that data for display via 
TraceGraph. 
 

Event Event - 1) For a given waveform, the occurrence of a state 
change which results in the recording of one point of data.  See 
also "List of Events".  2) The point at which sampling occurs. 
 

General NCK Reset Same as "NCK Reset - General". 
 

Global User Data (GUD) A database of variables that is accessible by all part programs.  
Often contains data specified by multiple providers such as: 
1. System GUDs (provided by Siemens). 
2. OEM GUDs (provided by a machine manufacturer). 
3. User GUDs (provided for a part program or specific factory 

floor application). 
          4. GUD 4 through GUD 9 (special purpose). 
 

Graph Same as "Waveform". 
 

Graph window The area of the screen where acquired data is displayed as one 
or more waveforms. 
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Event 1. For a given waveform, the occurrence of a state change 

which results in the recording of one point of data. 
2. The point in time when sampling occurs. 
 

Event Channel The Sinumerik channel in which a specific event occurs.  (See 
the appropriate Sinumerik documentation for a definition of the 
term "channel".) 
 

Event-only Signal A special recording case in which no data is recorded.  (I.e., only 
the time of the event is recorded.) 
 

Expert List A modifiable spreadsheet of configuration data that should only 
be modified by an expert. 
 

Insert The process of placing a duplicate of a waveform from one 
session into another session.  See also "Copy" and "Load". 
 

IPO Trace Same as "NCK Trace". 
 

Live Waveform A waveform that is updated with new data when the "Record" 
button is clicked. 
 

Load (a waveform) A waveform characterization process that is executed during the 
opening of a session file.  Waveforms can be loaded as either 
"Standard Waveforms" or "Reference Waveforms".  See also 
"Copy" and "Insert". 
 

Local User Data (LUD) Variables which are valid only in the part program or subroutine 
in which they were defined. 
 

LUD See "Local User Data". 
 

Metadata 1. Characteristics of data existing elsewhere in the machine 
environment, including type, units, description, access rights, 
storage location, array length, etc.   

2. Literally, "data about data".   
 

NCK Reset A re-initialization of the NCK Data that causes modified machine 
data to take effect.  (confirmation required) 
 

NCK Reset - General A re-initialization of the NCK Data that deletes all data in the 
battery-backed memory (SRAM) and loads standard machine 
data (confirmation required to initiate; all user settings will be 
lost). 
 

NCK Trace (a.k.a. IPO 
Trace) 

The NCK's data logging facility.  A software module in the NCK 
that collects information for the Trace Server (see below).  The 
information is raw trace data that is in a format not usable by 
SinuCom NC Trace. 
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PLC Symbols The names used for accessing PLC Variables, including: 

1. PLC VDI Symbols (names of PLC data created by Siemens 
and shipped with a version of the PLC software). 

2. PLC OEM Symbols (metadata created for a particular 
machine application by a machine manufacturer). 

 
 
PLC Variables The variables (either PLC or VDI)  that represent the state of a 

SIMATIC PLC. 
 

Plot Same as "Waveform". 
 

Program User Data (PUD) 
(a.k.a. Program Global 
Variables) 

Local User Data, defined in the main part program, that have 
been "globalized" by a setting in the machine data.  Note that 
PUD may be written and read on all subroutine levels. 
 

 
Qualifier An extension of the description of a signal that is required to 

resolve that signal to a unique entity. 
 

 
Reference Waveform A static waveform that is created from an existing waveform 

(standard or reference).  This waveform type is NOT updated 
with new data when the record button is clicked. 
 A Reference Waveform has many of the characteristis of a 
Standard Waveform, but differes in the following important ways: 
 
Its data and display remains unchanged when a new recording 
session begins.  (I.e., its data is not updated during a recording 
session.) 
 
It can be repositioned horizontally (e.g., to synchronize it with 
waveforms recorded at a different time.) 
 
It can be created from an existing waveform that has recorded 
data, either by "copying" a waveform in the current session or by 
"inserting" a waveform as reference from another file. 
 
See also "Waveform" and "Standard Waveform". 
 

Requirements, User See "User Requirements". 
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Safe Operating Stop A SinuCom NC SI Acceptance Test type which tests the ability of 

a machine axis to stop safely. 
 

Safe Software Limit 
Switch 

A SinuCom NC SI Acceptance Test type which tests the software 
travel limits of a machine axis. 
 

Safely Reduced Speed A SinuCom NC SI Acceptance Test type which tests the ability of 
a machine axis to safely reduce speed. 
 

Session An environment constructed for the purpose of collecting data.  
This DATA can be used to display one or more waveforms in a 
configurable manner. 
 

SI Acceptance Test A function in SinuCom NC which facilitates testing of safety-
relevant machine functions and documentation of same, as 
required by EC Machine Directive EN954-1 (Control Category 3). 
 

SI Wizard Same as "SI Acceptance Test". 
 

Signal A variable that can be recorded by Trace, or can be used as one 
of the elements of a trigger. 
 

Signal Data Same as "Data". 
 

Signal Description Text providing information about a signal (can be overridden by 
the user). 

Signal ID The unique numeric identifier (MD number) of a waveform (in the 
context of the SinuCom NC Trace "Setup: Waveforms" dialog). 
 

Signal Name The name of a waveform. 
 

Signal Specification Technical description of the signal as it is understood by the 
Sinumerik NCK or PLC...may be an address, a BTSS link item, a 
variable name, a Sinumerik reference, or other syntax. 
 

SinuCom NC The configuration tool for commissioning of the Siemens 
SINUMERIK line of controls. 
 

SinuCom NC Trace 
 

A facility that records and plots dynamic information from the NC, 
drives, PLC, and/or HMI.  Also known as “Trace HMI” and “Trace 
UI”.  The SinuCom NC Trace application that runs when the user 
selects "Diagnostics-->Trace" from SinuCom NC.  See also 
"trace" (lower case "t"). 
. 

Standard Waveform A waveform that is updated with new data when the record button 
is clicked.  See also "Waveform" and "Reference Waveform". 
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Start Trigger A trigger that initiates the recording of a waveform. 

 
Stop Trigger A trigger that terminates the recording of a waveform. 

 
Symbol A name for a piece of data in memory.  With respect to Trace, 

these can be GUDs or or PLC variables, and have the following 
common characteristics: 
1. PLC VDI and NCK BTSS symbols are synchronous with a        

release.  
2. New symbols are added asynchronously to an NCK release. 
3. New symbols are added asynchronously to a PLC release. 
4. Users of Trace may be called upon to import these symbols. 
 

Symbol File A file containing information correlating names with memory 
addresses.  (Other metadata may also be present, depending on 
the source of the file.) 
 

System Resources The resources that the NCK can provide.  (E.g., if the NCK allows 
only one slot, only one Trace Application can run at a time.)  Note 
also that User Requirements can exceed System Resources.  
See also "User Requirements". 
 

 
Template Same as "Custom Template". 

 
Template Test An installed test that is the result of loading a "SinuCom NC SI 

Acceptance Test" custom template.  See also "Custom 
Template". 
 

Trace  
(upper case "T") 

Same as "SinuCom NC Trace". 

trace 
(lower case "t") 

A generic term that applies to a graphical presentation of data, 
whether it is on a SINUMERIK control or elsewhere. 
 

Trace Checker A utility service used to verify that adequate resources exist and 
are properly configured when a user attempts to run a SinuCom 
NC Trace application. 
 

Trace Graph The graphical presentation facility of SinuCom NC Trace. 
 

Trace Server 1. A facility within SINUMERIK that collects and caches data from 
NCK Trace and formats that data for it clients (e.g., SinuCom NC 
Trace, and SI Acceptance Test [through Trace UI Core]).  Note 
that the caching of data is done asynchronously to the running of 
Trace.  Additionally, the Trace Server transforms the data from a 
Trace Session XML file into a setup for a Trace Session. 
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Trace Session Same as "Session". 

 
Trace Setup Wizard A six-screen user interface that allows easier configuration of 

Trace Server and NCK IPO Trace features. 
 

Trace Data Any data that is gathered that describes a waveform. 
 

Trace HMI Same as "SinuCom NCTrace". 
 

Trace UI Same as "SinuCom NCTrace". 
 

Trace UI Core The trace facility with the Trace front end (i.e., SinuCom NC 
Trace's UI) stripped off, which provides the services necessary to 
display plots.  Additionally, Trace UI Core is the repository for the 
display data pipeline between the Data Manager and 
TraceGraph.  Trace UI Core can operate in the SINUMERIK 
environment where a mouse or other pointing device is not 
available. 
 

Trace XML The storage format for the data. 
 

Trigger 1. The occurrence of a state change that initiates or terminates 
the recording of a series of data points.  

2. The satisfaction of the trigger level, according to the trigger 
mode, by the trigger waveform. 

 
Trigger Event A specific entry in the list of events entitled "Trigger Event". 

 
Trigger Level The value a trigger must achieve for the trigger event to occur.  

(NOTE: Units for the selected trigger level are pre-defined in the 
database.) 
 

Trigger Mode Either an arithmetic operator (e.g., "equals“, "greater“) or a 
characteristic of the trigger (e.g., "rising edge“). 
 

 
Waveform A single graphical plot of a series of recorded data points that is 

associated with a signal at an event (synonymous with "Plot", 
"Graph" and "Trace").  
 

Waveform Data The complete set of data points, collected at the occurrences of 
the event, required to describe a given waveform  (data plus the 
event).  Recorded data representing the behavior, and thus the 
waveform, of any variable. 
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A.3  References 
    

A monthly updated overview of publications showing the languages 
available can be found on the internet at: 
 
http:/www.siemens.com/motioncontrol 
 
via "Support", "Technical Documentation", "Overview of Publications". 
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